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Introduction 

How It All Began 

In early 2003 Peter PHP1PH and myself Simon HB9DRV talked about 

developing a simple program to control the soon to be released ICOM IC-703. 

We had previously developed the FT-817 Commander, which proved to be very 

popular, the main lesson being learnt that future programs must not be tied to a 

single radio or a single manufacturer; rather they must be designed to support all 

current and future radios. 

Maybe it was the beer, maybe the desire to give something back to the radio 

amateur community, however on June 6
th

, 2003 the first line of code was written, 

Ham Radio Deluxe (HRD) was born. 

The inspiration for the design came from a variety of sources: Internet Explorer 

(especially the Favourites), my old Eddystone EA12 and a desire to prove that 

Peter and myself could develop something better than the current „not quite so 

free and fantastic‟ products being peddled to radio amateurs. 

On December 23
rd

, 2005 the number of registered users stood at 20,006 – quite 

an achievement in such a short time. 

---   ---   --- 

Very sadly Peter passed away on June 8
th

, 2005. His contribution to Ham Radio 

Deluxe will never be forgotten. 

 



This Guide 

Kevin Crockett, VK3CKC, wrote the original user guide. Now that HRD is a 

more mature product the time has come to write the document you are currently 

reading. 

Thank-you for reading this guide - and before you ask it‟s written in British 

English, with plenty of my favourite colours despite Word‟s attempts to change 

the spelling . 

If you are only going to read one more section then now go to Radio Display on 

page 23. 

Please report errors and omissions to simon@hb9drv.ch or in the HRD forums 

http://forums.ham-radio.ch/ . 

The Name 

The influence for the name comes from Eight Ball Deluxe, which was one of the 

finest Macintosh games of the 1990‟s. 

   

Sponsors 

To help keep HRD free for all Amateurs and SWL‟s several companies have 

helped by sponsoring the HRD development. If I have missed your company 

please let me know. 

And a very big thank-you to everybody when has lent radios to Peter and myself 

so that we have been able to provide the current level of support. 

 

mailto:simon@hb9drv.ch
http://forums.ham-radio.ch/
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Requirements 

Computer 

You can run HRD on any Windows 98 or Windows NT/2K/XP computer. Please 

note: version 3.4 is the last release that will „intentionally‟ run on Windows 98. 

There will never be a LINUX or Macintosh native version, HRD is known to run 

under Wine for LINUX and PC emulators for the Macintosh. 

 

I may be crazy undertaking a project like this in my spare time
1
; I am not „deep 

stir-fry serve in a bun with extra chilies‟ crazy
2
! 

 

The code is not open source; it cannot be ported to Linux and will never be 

released as some of the code is protected under copyright and if released will 

land the author with a nice big legal „fee‟. 

Supported Radios 

You don‟t need a radio – HRD comes with built-in Dem-o-matic radio support 

(FTDX-9000, K2, Orion, TS-480, TS-570 and TS-2000). 

HRD currently supports these „real‟ radios: 

 Elecraft: K2 

 FlexRadio: SDR-1000 

 ICOM: IC-7000, IC-703, IC-706, IC-706MkII, IC-706MkIIG, IC-

707, IC-718, IC-725, IC-726, IC-728, IC-729, IC-735, IC-736, IC-

737, IC-738, IC-7400, IC-746, IC-746Pro, IC-751A, IC-751A 

(Piexx), IC-756, IC-756Pro, IC-756ProII, IC-756ProIII, IC-761, 

IC-765, IC-775DSP, IC-7800, IC-781, IC-821H, IC-910H, IC-R10, 

IC-R20, IC-R7000, IC-R75, IC-R8500, IC-R9000, PCR-1000 

 Kenwood: R-5000, TS-140S, TS-2000, TS-440S, TS-450S, TS-

480, TS-50S, TS-570, TS-60S, TS-680S, TS-690S, TS-790, TS-

850, TS-870, TS-940S, TS-950, TS-B2000 

 Ten-Tec: Argonaut, Jupiter, Orion, RX-350 

 Yaesu: FT-100, FT-1000D, FT-1000MP MkV, FT-600, FT-817, 

FT-840, FT-847, FT-857, FT-890, FT-897, FT-900, FT-920, FT-

990, FTDX-9000. 

                                                           
1
 It was the voices in my head that made me do it 

2
 Medical opinion may differ here 



Interfacing 

You will need a cable to connect your radio to the computer‟s serial (COM) port. 

If you don‟t have a serial port all is not lost – USB  serial converters are 

widely available. Please note: not all USB  serial converters work well enough 

for HRD. If in doubt ask for a recommendation in the HRD support forums. 

For more interfacing information refer to: 

 The HRD Interface guide, and 

 CATbox, a Modular Computer Interface by Bas Helman G4TIC. 

These files are downloadable from the HRD download center - http://hrd.ham-

radio.ch/downloads.html. 

Check out the cable solutions from: 

 G4ZLP http://g4zlp.ham-radio.ch/ and 

 West Mountain Radio http://www.westmountainradio.com/.  

Public Interfaces 

Other (non-HRD) programs are supported via a DDE interface (see DDE 

Support on page 61) and a serial port (see 3
rd

-Party Programs on page 149). 

Logbooks typically use these interfaces; for example contest-oriented logbooks.

http://hrd.ham-radio.ch/downloads.html
http://hrd.ham-radio.ch/downloads.html
http://g4zlp.ham-radio.ch/
http://www.westmountainradio.com/
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Installation 

Introduction 

The Ham Radio Deluxe kit is a standard Windows kit – it supports Windows 98, 

Windows 2000, XP and more recent releases. Please note: version 3.4 is the last 

release that will „intentionally‟ run on Windows 98. 

The Logbook uses the Microsoft Jet 4.0 Database Engine, see Database on page 

73 for more information. 

Ham Radio Deluxe 

Ham Radio Deluxe can be installed in under a minute. Special knowledge is not 

needed – the kit does everything for you! 

You will not need to reboot your computer, HRD does not update your system 

files or change your system‟s configuration in any way. 

 

When you start the installation the first screen shows the release and build you 

are installing. 

 



 

You must accept the licencing conditions. Ham Radio Deluxe is free for radio 

amateurs and shortwave listeners, commercial use requires a licence. 

If you are a commercial (non-amateur user) stop the installation now unless you 

have a licence. 

 

 

Select the folder where Ham Radio Deluxe will be installed, the suggested 

default is usually sufficient. 
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Select the folder in the Start menu where the Ham Radio Deluxe entries will be 

added, the suggested default is usually sufficient. 

 

 

Click Install to start the installation. 

 



 

The progress of the installation is shown while the software is being installed. 

 

 

When the software has been installed select the programs to be started, then 

press Finish. 
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First Steps 

Connection 

Now that you have installed HRD you can try it out using a Dem-o-matic radio. 

This is a reasonably accurate simulation of the real thing, designed for use 

during presentations and while developing HRD when a radio is not available 

(on the train, in a plane, in an airport, stuck in a hotel room in Finland etc.). 

From the Start menu select Programs > Ham Radio Deluxe. Once the splash 

screen has closed you see the Connect window. 

 

 

Dem-o-matic 

The Dem-o-matic radios do not need cables – simply select Dem-o-matic in the 

Company dropdown, select an option in the Radio dropdown, and then press 

Connect. 

They are ideal for demonstrating HRD when you do not have a suitable radio 

available. 

Options 

Company 

Select your radio manufacturer from the drop-down list.  



FlexRadio: you must install the vCOM virtual serial port drivers from Philip 

Covington (N8VB). These are used to provide the connection between HRD and 

the PowerSDR sofware that must be running before you try to create the 

connection with HRD. More information is available from http://www.flex-

radio.com/, to install the vCOM drivers see Annex: N8VB vCOM on page 163. 

ICOM: disable the CI-V Transceive option for best performance. 

Kenwood: make sure Packet communication mode is switched OFF (if 

supported). Most Kenwood radios require CTS and RTS to be ON for flow 

control. 

Radio 

Select your radio model from the drop-down list. 

COM Port 

The COM port on this computer where you have connected the radio interface 

cable. 

Make sure that you do not have other programs using the same port, for example 

mobile phones and personal organisers. 

Select 'Auto-detect' to try all available ports. 

Speed 

The speed used for communicating with the radio, check the speed setting via 

the radio's configuration menu. 

Select 'Auto-detect' to try all available speeds. 

CI-V Address 

ICOM only: the address assigned to the radio, consult the radio's handbook for 

the default address. This can also be configured via the radio's configuration 

menu. 

CTS 

Enables the CTS flow control, required for Kenwood radios. 

DTR 

Enables the DTR line when the COM Port is opened and leaves it on, usually to 

provide power for an interface cable. For Yaesu CT-62 and ICOM CT-17 

interfaces this can be left unchecked (off). 

RTS 

Enables the RTS line when the COM Port is opened and leaves it on, usually to 

provide power for an interface cable. For Yaesu CT-62 and ICOM CT-17 

interfaces this can be left unchecked (off). 

Connecting 

Press Start to connect to the radio. If you see the error below then the COM port 

is currently held open by another program. 

 

Check that you have not started another radio control program. Other culprits are 

PDA and mobile phone connections. Even if you have disconnected a device 

from a COM port you must make sure that the software is no longer running. 

http://www.flex-radio.com/
http://www.flex-radio.com/


 First Steps    21 

One connected HRD reads the radio‟s frequency to ensure that the options you 

selected are correct. If you see the error below then HRD failed to read the 

radio‟s frequency: 

 

If HRD can read the frequency the Connect window is replaced with the main 

radio display – you are now using HRD! 

If HRD cannot read the frequency then check: 

 Correct COM port is selected, 

 Speed on radio is the same as the speed selected in HRD, 

 Your cable – you may have a NULL modem cable when a normal 

serial cable is needed, 

 Cable is connected correctly to your PC (you may have more than 

one COM port), 

 DTR / RTS are selected if required to power an active cable such as 

CT-62 or a cable from third-party provider. 

If you still can‟t get started refer to: 

 Annex: Command Tester on page 153, and 

 Annex: Portmon on page 161. 

What’s Next 

A taste of what‟s to come later in this guide… 

Appearance 

Set the appearance: 

 From the View menu select Colour Schemes, 

 Select Customise Layout and Program Options from the Tools 

menu. 
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Radio Display 

Introduction 

The HRD radio display has many, many features. This section attempts to 

describe everything you can do in this display. 

HRD is designed to be intuitive; nevertheless even the author has problems 

remembering all the available options! 

To aid in the clarity of the screenshots the LCD Scheme is used. 

 

 



Frequency Display 

 

Configuration 

See Frequency on page 34. 

Dropdowns 

If you have enabled dropdowns as part of the configuration just click on a 

dropdown and make a new selection. 

Mouse Wheel 

When you rotate the mouse wheel in the frequency display the currently active 

digit is incremented / decremented depending on the scroll direction. 

If you rotate while the cursor is over an inactive digit then the digit is activated. 

Up/Down 

The up-arrow, down-arrow, - and + keys increment / decrement the active digit. 

Mouse-click 

Select a digital by clicking over the digit. To increment / decrement click above / 

below the center of the digit and keep the mouse button pressed. 

Direct Entry 

To enter values just press a numeric key (0-9). The active digital is updated and 

the next digit to the right is made active. 

Press Enter to display the Enter Frequency window. 

 

Enter the new frequency, and then press Apply. 

If you check Auto-apply then the new frequency is applied every time you make 

a change. 

If you check Track this window is updated with changes made to the frequency 

display – for example when you tune the radio manually. 

Griffin etc. 

Support for third-party devices such as the Griffin Powermate is available – see 

Accelerators on page 39. 
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Tuning Dial 

Fine Tuning 

 

There are two fine tuning ranges – Fine I and Fine II. In the Tuning menu select 

Show Fine II to show the second range. (If you are only showing Fine I then the 

title is Fine.) 

Set the range from the Tuning menu or by clicking the  button. 

To change the mouse wheel step click the  button (also set with the Mouse 

Wheel pane of Program Options on page 44). 

To change the frequency either: 

 Drag the marker with the mouse (and keep on dragging – the bar 

will scroll to the left or right), 

 Rotate the mouse wheel (press Shift to increase the mouse wheel 

step by a factor of 2, press Ctrl to increase by a factor of 5),  

 Click in the tuning bar or on frequency text such as 14.235.0. 

Main Tuning 

 

The differences between a main tuning bar and a fine tuning bar are: 

 The range is fixed (defined by the Band Layouts on page 57), 

 The bar does not automatically scroll to the left or right. 

Band Selection 

The Band Section buttons are shown between the Fine and Main layouts. 

 

The buttons are: 

 ALT, 

 BSP, 

 Band buttons – 160m, 80, … and 10m. 

ALT – only displayed if you have two VFO‟s displayed (for example Kenwood 

TS-2000), switches between the main and alternate (second) VFO. When 

highlighted you are tuning the second VFO with the tuning dial. 

BSP (bandspread) – when you press BSP a new layout is dynamically created. 

The current band is split into multiple segments, for example the 20m band (14 

MHz – 14.350 MHz) can be split into 7 segments, each of 50 kHz. 

To restore the previous layout press BSP and select Off. 

The band buttons select the corresponding band; the last used frequency and 

mode for the band are restored. 



Display Scroll 

 

If there is not enough room to display all the frequency ranges defined in the 

current band layout use this button to scroll the frequency ranges (bands) up or 

down. 

Band Selection 

 

The current band layout. Click here to select a different layout from the Bands 

menu. 

 

Date & Time 

 

Click here to set the clock format. 

 

Buttons 

 

What would a radio be without buttons? Press a button to active the option. If it 

is a button where the option state can be read from the radio – for example the 

selected VFO – the button indicates whether the option is currently selected. 

This should be obvious  . 
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Dropdowns 

 

When to press a dropdown button a popup menu is displayed. Select an option or 

press escape. If possible the dropdown displays the current selected option. 

Again, this should be obvious. 

Sliders 

 

Select the sliders that are displayed with the Sliders: Layout pane of Customise 

Layout – see page 36. 

Use the mouse to adjust a slider value. 

In the View menu select whether sliders are displayed with the Slider Controls 

option.
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Customise Layout 

Introduction 

Used to define the appearance of the radio display, Customise Layout is selected 

from the Tools menu, or by pressing the Customise button. 

 

Schemes 

 

Schemes are pre-defined customizations created by author and by other HRD 

users. 

There are four default schemes shipped with HRD: Scheme #1 - #3 and the 

System Default. 

The HRD team and the HRD users have created the other schemes. Special 

thanks to Danielle in Northallerton, UK. 



Select a default scheme by pressing the scheme button (or select an entry and 

press Select); select one of the other schemes by double-clicking on the entry in 

the Schemes list. 

To save the current layout press Save – you will be prompted for a Scheme 

name. 

Use Rename and Delete to organise the available schemes. 

Layout 

 

HRD is a data-driven program. For each radio there is a table of supported 

commands and associated button / dropdown / slider names. The layout order is 

more-or-less alphabetical. 

An early complaint was that the buttons positions were not user-definable; as a 

result the Layout window was designed. 

Don‟t be put off by the amount of information in this window – take it slowly 

and read the information here. 

The layout definition is saved on a per-radio basis in the registry. 

Dropdown Button / CAT Command / Macros 

You can create new buttons  - for example, to create a USB button from the 

Mode dropdown: 

 Select an empty button position – the selected entry will start to 

blink (you can reposition this button later), 

 Press Select (above the Save and Load buttons), 

 In the Configure Button Mapping window select Mode : USB and 

enter the text to appear on the new button, then press OK. 
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 The previously empty button position now has a new value – USB! 

Hiding 

Hide dropdowns hides the dropdown buttons to the right of the layout window, 

releasing two columns where you can assign new button definitions. 

Hide status texts hides the three top-left meters (-1-, -2-, -3-) and the status text 

area underneath, releasing two columns where you can assign new button 

definitions. 

Moving Entries 

Move the selected entry by simply dragging it with the mouse or by using the 

four arrow-buttons. 

    

Removing Entries 

To remove an entry either drag it into the Unassigned list or right-click on the 

button and select Clear from the popup menu. 

Dropdowns 

Select the dropdown menu, and then simply drag an entry to an unused location 

in the display. 

If you drag to a location that already has a definition the current definition is 

removed, if a standard button it is returned to the unassigned list.  

Unassigned 

Entries in the Unassigned list are standard buttons that are not currently 

displayed. Simply drag an entry to an unused location in the display. 

If you drag to a location that already has a definition the current definition is 

removed, if a standard button it is returned to the Unassigned list. 

Styles 

In the Buttons pane (page 32) you define up to seven button styles, shown here 

in the Button Styles group. 

To assign a style to a button either: 

 Drag the style over the button, or 

 Click a style to apply it to the currently selected (blinking) button. 

Save / Load 



To distribute your layouts with other users of your radio model use the Save and 

Load buttons. 

Buttons 

 

Define: 

 Seven button colour combinations, 

 The font, and 

 The button size. 

The default button size is small; this is so that users with low resolutions such as 

800 x 600 still have a usable configuration. 

There are no rules when using the button size; select the size which pleases you 

most. 

For the technical readers the button size is tied to the font size of the radio 

display form (font is Microsoft Sans Serif, size is 8, 9, 10 or 12 point). 

Changing the font size simply changes the font assigned to the form. 
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Faceplate 

 

Background 

These colours are applied to the background area of the display and to the 

transmit meters (if any) such as PWR, SWR and ALC. 

Status Window 

The status window displays information which you cannot normally change 

using buttons or sliders in HRD. 

Typical examples are Scanning status, Split mode and Memory channels. 

Clock Position 

The clock is displayed to the left, right or both sides of the band title. 



Frequency 

 

If your radio supports simultaneous access to two VFO‟s (Kenwood, some 

Yaesu) then HRD will display two VFO‟s, otherwise just one VFO is displayed. 

First select the VFO you are updating – main or sub. 

The colours you can set are: 

 Background, 

 Frequency – the digits, 

 Active Posn – the bar above and below the current digit, 

 Inactive Posn – the bar above and below the other digit, 

The Font can also be set, use the Main > Sub and Sub > Main buttons to copy 

settings between VFO‟s. 

Dropdowns 

The dropdown buttons (Mode, Filter…) can be displayed at the top of the main 

frequency display. 

Select: 

 None (no dropdowns), 

  Mode (only the mode dropdown) or 

 All (all dropdowns). 

If Mode or All is selected you can check Add Border to add a border around the 

text. 

If All is selected you can check Include Title to add the Dropdown button„s title 

(if there is room). 
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Meters 

 

The design aim of the bar meters was heavily influenced by my fine Sony stereo, 

still giving fine service here in the HRD R&R suite after some 15 years of abuse. 

The Background and Text colours should be obvious. 

There are three graduation colours: 

 Bars: Low – the first bar colour, 

 Bars: High – the colour at the position set by the High Position 

slider, and 

 Bars: Free – the colour for the free (empty) bars. 

If you check Show peak reading the recent peak value is displayed. 

When HRD is in TX mode the S Meter value is replaced by the value selected in 

the Main and Sub dropdowns, the value you select must be displayed by HRD in 

the upper right hand corner of the display. For Kenwood radios the value to be 

displayed is selected with the meter slider or the individual buttons (SWR / 

Comp / ALC / dB). 

If you check the Always update… option then the S Meter is updated when you 

change frequency – this results in slower performance. 



Sliders: Appearance 

 

If supported by your radio, sliders are displayed at the bottom of the display. 

Here you define the appearance of the sliders. 

These colours are optionally applied to the sliders in the Advanced selection 

windows (select Advanced from the View menu). 

Sliders: Layout 

 

Here you select the sliders to be displayed. Define up to 6 layouts, for example 

one layout for SSB and another for CW 
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Tuning Dial 

 

Here you define the colours, fonts and band button positions. 
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Program Options 

Introduction 

Used to define various HRD features, Program Options is selected from the 

Tools menu, or by pressing the Options button. 

 

 

Accelerators 

 

Define accelerators for use with the Keyboard or with programmable interfaces 

such as the Griffin Powermate. 

When you press Add the definition window is displayed. 



 

Here Ctrl+Alt+W is assigned to the Tune button. Keyboard combinations are 

assigned to display buttons and arrow keys. 

The HRD menu has pre-assigned accelerators; these cannot be redefined. 

Comms 

 

Normally you will not have to change the default settings. 

 Read timeout – serial port timeout. 

 Switch off – some radios such as the FT-817 can be powered down 

using a CAT command. If this option is selected you are prompted 

to switch off the radio. 

 Polling – to reduce CPU load for slower systems. 

 Dual VFO tracking – if selected both VFO‟s are tracked on every 

refresh. Only of use with Satellite Tracking (page 129). 

 Refresh interval – the interval between consecutive refreshes of the 

display. 
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COM Port TX 

 

Some early ICOM radios do not support switching between TX and RX using 

CAT commands. The only way to enable computer controlled TX/RX this is by 

toggling a COM port pin. 

You require a special CAT cable if you select this option. 

ICOM Calibration 

 

ICOM radios return a S Meter value between 0 and 255, normally 0 is S0, 12 is 

S1 and so on. 

As a S Meter unit is 6 dB the algorithm applied is to divide the returned value by 

two to get dB, then divide dB by 6 to get S units. 

Some radios such as the IC-706 have a different logic – use the Offset and Scale 

values to adjust the returned values so that the S Meter in HRD corresponds to 

the S Meter on your radio. 



Info: Modes 

 

Mainly for use by the HRD programming team, all modes for each radio are 

listed. For each mode the mapping to the internal HRD mode is shown. 

Info: CAT Support 

 

Mainly for use by the HRD programming team, all commands are listed for each 

radio. 

Press Radio for a list of all supported radios. 

To display the commands: 

1. Select a radio, 

2. Press Viewer. 
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Internet 

 

HRD is able to detect whether you have an Internet connection with 

InternetGetConnectedState(). Uncheck this option if you do not want Internet 

access. 



Out Of Band 

 

Configure the optional sound files played when you tune in / out of band. 

Mouse Wheel 

 

Define the tuning step when rotating the mouse wheel over the active tuning bar. 
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Selection Window 

 

The appearance and operation of the selection window. 

Single-click – normally the Favourites tree folders are opened / closed with a 

double-click. Check this option to enable single-click operation. 

Show numeric value – the Select Windows‟s Advanced slider values are 

optionally superimposed on the slider. 

Show the Options icon – historical support for the version 2 Advanced slider 

look and feel. 

Themes 

 

HRD uses the excellent programming library from Codejock Software to support 

toolbars, main window tabbing and docking pane options 

Docking panes are used for optional windows such as: Bandscope, Calendar, DX 

Cluster, Logbook, Selection, Shortwave Database and WinKey. 

Main Theme 

Select whichever visual theme you want – Office 2003 is an acceptable default. 

System Theme 

http://www.codejock.com/


When you select Office 2003 or Windows XP for Menus and Toolbars you can 

select an optional System theme. 

Main Tabs 

If you have more than one main window open – for example Radio and Logbook 

– then the main tabs are a useful way of switching between windows. 

 

 

Updates 

 

Select how frequently HRD reminds you to check for new updates. 

Yaesu 
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Special options for Yaesu radios. Due to firmware „features‟ in the FTDX-9000 

it is necessary to wait up to 250ms after writing a command to the radio. With 

any luck Yaesu will fix this at some date in the future. 
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Audio 

Introduction 

HRD has a built-in audio grabber and audio playback. The long-term aim is to 

automatically add audio clips into the logfile. 

Audio Grabber 
The audio grabber stores incoming audio in MP3 files using the MP3 tags to 

store information about the radio settings (or any other information you feel to 

be important). 

An alternative to MP3 would be Windows Media format (WMA) but the 

programming of WMA files is rather complex. 

To display the audio grabber select Audio Grabber from the Tools menu. 

Record 

 

Here you have the standard recording buttons. From left to right: 

 Record, 

 Stop, 

 Reset current recoding, 

 Restart (close current file first), 

 Browse for MP3 files. 

You also set a file limit – a downside of MP3 is that the tags are written at the 

end of the file when it is closed, so to avoid losing information in the event of an 

unexpected event it is best to use more, smaller files. 



Folder 

 

Here you select the folder where the MP3 files are stored. 

Quality 

 

Here you select the bandwidth and quality. Modern computers have more than 

enough CPU power to support a very high quality. A bandwidth of 4.5 kHz is 

usually acceptable unless you are recording a WFM broadcast. 

Soundcard 

 

Select the soundcard that you are recoding from. 

Tags 

 

Here you see the values stored in the MP3 tags. To change the values just add 

the new text and then press Apply. 

Audio Browser 

Use the audio browser to playback MP3 files. 
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 Select the folder to browse 

 Select default folder 

 Refresh the current folder 

Select MP3 player – a basic MP3 player is built into HRD, however you can 

select an alternate player such as the excellent Windows Media Player. Press 

Default to select the default player. 

Peter PH1PH came across IrfanView – an excellent utility. 

MP3 Player Options 

Select a file to play from the list at the bottom of the window. 

 Play currently selected file 

 Pause 

 Start again 

 Stop 

From 

 Start at beginning of file 

 Set „From‟ to the current position 

To 

 To end of file 

 Set „To‟ to the current position 

http://www.irfanview.com/


Use the From and To slider positions to select the part of the file to repeated over 

and over and over again. This is useful for determining exactly what the station 

was sending. 

Other Options 

The other options are: 

 Copy – copy the selected files to another folder. 

 Delete – delete the selected files. 

 Move – move the selected files to another folder. 

 Rename – rename the selected file. 

 Artist / Album / Title / Description – change the MP3 tags. 
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Auxiliary Switching 

Introduction 

A standard PC comes equipped with an 8-bit parallel port that can be used to 

switch auxiliary equipment such as antennas, bandpass filters and power 

amplifiers. 

Ham Radio Deluxe supports the parallel port via fully configurable manager and 

monitor displays. 

Typical uses of this option are to switch antennas, either automatically as the 

frequency changes, or by selecting an option from the Parallel Port pane of the 

selection window. 

Technology 

The parallel port sends 8 bits at a time. The layout of the parallel port pins is 

shown below.  

 

The data pins are shown in red; D0 is pin 2, D7 is pin 9. 

To indicate that a bit has a value of 1, a charge of 5 volts is sent through the 

correct pin. No charge on a pin indicates a value of 0. This is a simple but highly 

effective way to transmit digital information over an analog cable in real-time.   

Manager 

The manager window is invoked from the Tools > Parallel Port menu. 

Definitions 

Each definition consists of: 

 [X] Enabled selection – if not checked then the definition is 

ignored when Ham Radio Deluxe detects a new frequency. The 

definition is still shown in the selection window if this option is 

enabled. 

 Title – a description of the antenna or component that will be 

switched when the entry is selected. 



 From – the lower end of the frequency range. 

 To – the upper end of the frequency range. 

 Port – the LPT port to be switched by the definition. 

 D0-D7 – the parallel port data bit settings, each bit is either 1 (on) 

or 0 (off). D0 is pin 2, D7 is pin 9. 

Port Address 

The default port addresses for LPT1, LPT2 and LPT3 are 0378, 0278 and 03BC 

respectively. If your computer has a different configuration just select the 

address that corresponds to the port. 

You will find the port address via the Device Manager settings display located in 

the System control panel applet. 

 

In the Windows XP example below the base address is 0378. 

Various 

The options are: 

 Auto-switch: as the frequency displayed by Ham Radio Deluxe 

changes a lookup is made against the parallel port definitions and 

the parallel port switched to the configuration for the first 

definition in the list that matches the new frequency. 
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 Selection window: displays a Parallel Port pane in the main HRD 

selection window. See Selection Window on page 45. 

Monitor 
The monitor window is started from the Tools > Parallel Port menu. The 

monitor: 

 shows the current state of the data pins for a selected parallel port, 

 allows you to select a definition, and 

 toggle the data pins directly. 

 The Definition field shows the definition that matches the current pin selection 

(if any). 

 Selection Window 

To display the selection window select the selection window option in the 

Parallel Port Manager. 

 

The options are: 

 Manager – starts the Parallel Port Manager. 

 Monitor – starts the Parallel Port Monitor. 

 Auto-switch – if enabled (tick) then a match is made with the first 

enabled definition when the frequency changes. If not enabled 

(cross) then a match is not made. 

 Definitions – click on a definition to apply the definition to the 

port. 

The icon indicates whether a definition that has been enabled or disabled. 

Disabled definitions can be selected in this window; they are only ignored when 

matching a new frequency against the list of definitions.
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Band Layouts 

Introduction 

A necessary feature of a fully customizable radio program such as HRD is the 

definition of custom band layouts. 

The IARU regions have own band plans; there is no doubt that these will change 

in the future. 

Consider also the traditionalist who has never owned a microphone in his life 

and is only interested in the CW portions of the bands – he wants his own band 

layouts. 

Manager 

To start the Manager select Manager from the Bands menu. 

 

Here you see the existing definitions. In the Edit menu you have the expected 

New, Copy, Modify and Delete options. 



Adding A Definition 

In this example a band layout is created for our CW enthusiast. Select New from 

the Edit menu to create a new definition using the Band Layout Editor. 

 

In the Title field enter CW Only. 

From the Edit menu select New to define a new frequency range. 

 In the Band field enter 160m 

 In the From field enter 1.800.000 

 In the To field enter 1.830.000 

 Ensure Enable is checked 

 Press OK 

 

When you press OK the frequency range is added to the band layout. 

Repeat for 80m and 40m: 

 80m, 3.5MHz to 3.55MHz, 

 40m, 7.0MHz to 7.05MHz. 

The band layout now looks like this: 
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To rearrange the order of the frequency ranges just select a range and use the 

Move menu options or the Move buttons  . 

When you have finished your new layout press OK. The CW Only definition is 

added to the band layouts. In the Band Layouts window press OK to save the 

definitions and close the window. 

Copying A Definition 

To copy an existing band layout: 

 Start the Manager, 

 Select the entry to be copied, 

 Select Copy from the Edit menu, 

 Enter the new title, 

 Change the frequency ranges are appropriate, 

 Press OK. 

Selecting 

To select a band layout either: 

1. Open the Bands pane in the Selection window (select Display from the 

Bands menu) and select an entry in the list, or 

2. Click on the Band Title 160m – 10m (Region 1) in the radio display 

and select a new layout from the popup window. 
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DDE Support 

Introduction 

HRD uses dynamic data exchange (DDE) for inter-process communication. 

DDE allows two or more applications running simultaneously to exchange data 

and commands. 

See also 3
rd

-Party Programs on page 149. 

Available Support 

Select DDE Monitor from the Tools menu to display the supported DDE items. 

 

Commands 

The commands below are supported by HRD. 



 

Add ADIF Record 

ADIF <data> 

Adds a record to the logbook; the record is supplied in ADIF format. Used by 

PSK31 Deluxe. 

Refresh 

REFR button_status  

Refreshes all buttons. 

REFR dropdown_list 

Refreshes all dropdown. 

Set Button 

BUTN button_title=value 

Sets a button state. For normal buttons the value is either on or off. 

 If title starts with @ then it‟s a dropdown, the value must be a dropdown value. 

Set Dropdown 

DROP button _title=value 

Selects a dropdown value. 

Set Frequency 

FREQ <hertz> 

Sets the frequency to the value supplied in Hertz. 

Set Mode 

MODE <mode> 

Sets the mode to the supplied value. 

Top Window 

TOPW 

Makes the HRD the top-most window in the Z-order, in other words brings HRD 

to the front of your monitor.
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DX Cluster 

Introduction 

A DX Cluster is a means for Amateur (Ham) Radio operators to tell each other, 

in real-time, about DX stations (other interesting or rare Amateur Radio stations 

all over the world). 

(From http://www.dxcluster.org/ by Dirk Koopman G1TLH) 

One station is set up with Packet Cluster and is linked to one or more other 

stations who have installed the software. These nodes when connected are called 

a cluster. Clusters are connected to clusters, expanding the network. Individual 

users connect to the nodes on a frequency different from what the node stations 

are linked on. Users are capable of announcing DX spots and related 

announcements, send personal talk messages, send and receive mail messages, 

search and retrieve archived data, and access data from information databases 

among its many features. 

(From http://www.dxcluster.org/ by Chuck K6PBT) 

HRD supports: 

 OH2AQ web-based cluster (the original and most widely used), 

 HRD‟s own web-based cluster, 

 Direct connections to a DX Spider node using a DX cluster client 

(which in turn uses the telnet protocol). 

The OH2AQ and HRD clusters are available using just your web browser. 

http://www.dxcluster.org/
http://www.dxcluster.org/
http://oh2aq.kolumbus.com/dxs/
http://dxcluster.ham-radio.ch/


OH2AQ 

 

HRD 

 

Starting 

Select DX Cluster from the Tools menu. 
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When you click on an entry the frequency is sent to the HRD display. 

Configuration 
Press  to open the Configuration window. 

Cluster Source 

There are three possible sources for DX spots: 

3. OH2AQ – the original and most widely used web-based cluster. 

The spots are read by parsing data from the pages on the OH2AQ 

site at http://oh2aq.kolumbus.com/dxs/ . 

4. Ham Radio Deluxe – a web-based cluster with data downloadable 

in CSV format from http://dxcluster.ham-radio.ch/ . These web 

pages were made available by the HRD team as the OH2AQ cluster 

can be overloaded at times, especially at the weekend and during 

contests. 

5. Custom – using the DX Cluster Client built into HRD. Here you 

connect to any DX cluster node. 

OH2AQ / Ham Radio Deluxe 

Using these web-based clusters is the easiest way to get started. All you need is 

an Internet connection. 

OH2AQ supports the Spot option; the Ham Radio Deluxe cluster offers a faster 

response when OH2AQ is overloaded. 

Custom – DX Cluster Client 

This option is only supported on Windows NT/2K/XP. It is not supported in 

Windows 98/ME/SE. 

In the DX Cluster Client pane you connect to a DX Spider cluster, for example 

GB7MBC in sunny Morecambe or HB9DRV in snowy Laax. 

http://oh2aq.kolumbus.com/dxs/
http://dxcluster.ham-radio.ch/


 

Here GD4ELI has logged on to GB7MBC. DX spots are displayed in this 

window as they are received and are sent to the DX Cluster window for 

immediate display. 

 

The advantage here is that you can apply any filtering supported by the DX 

Spider node you connect to. If your interest is European 144MHz then you don‟t 

want to see 144MHz spots from the rest of the world. 

Options 

Press  to enable regular updates; the update interval is set by pressing  (not 

applicable is using a custom DX cluster). Press  to refresh the display. 

 

 

Press  to change the font size. 

Select an entry in the display, then press  to perform a lookup of the station 

from the QRZ website. 

http://www.qrz.com/
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Press  to display the homepage for the selected source (not available if using a 

custom DX cluster). 

Press  to submit a spot (not available is using the HRD source). 
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Favourites 

Inspiration 

Obviously Internet Explorer had an influence here – as most computer users 

have experience with web browsers a conscious decision was made to use 

familiar concepts. 

Favourite definitions are selected from the Favourites pane in the Selection 

window. 

Manager 

Start the manager from the Favourites menu or the Favourites pane in the 

Selection window. It is designed to be easy to use – let‟s see. 

 

New Root – create a new top-level (root) folder. Folders are not saved if they are 

empty (no child folders or definitions). 

New Folder – create a new folder as a child of the currently selected folder. 



Sort Folder – sort the entries in the currently selected folder: 

 By title, 

 By ascending frequency, or 

 By descending frequency. 

Add – add a new definition. 

 

Enter the title, frequency and mode, and then press OK. The new 

definition is added to the current folder. 

You can also select Add from the Favourites menu to add a new 

definition. 

Del – delete the current folder or definition (depending on which you have 

selected). 

Move – move an entry to another folder (alternatively drag entries between 

folders with your mouse). 

 

Select the new folder, then press OK. 

Copy – make a copy of an existing definition. 

Edit – edit the selected folder / definition. 

Arrows – rearrange the selected folder / definition. 

Load – load a new set of definitions from a file previously created using HRD; 

all current definitions are discarded. 

Merge - merge definitions from a file previously created using HRD. 

Defaults – restore the default list (hard-coded into HRD). 
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Save – save current definitions to a file. 

Markers 

To display markers in the HRD display select Show Markers from the 

Favourites menu. The marker size is selected from the Marker Size option in the 

Favourites menu. 

 

The popup text is displayed as you move the mouse pointer over a marker. The 

text is constructed from the favourite title and frequency. 





 Logbook    73 

Logbook 

Introduction 

The logbook was originally planned to be a simple replacement for the standard 

paper logbooks that one can purchase from all major radio societies. This idea 

didn‟t last long as the user requests piled in; as a result a more sophisticated 

logbook was implemented. 

Other (non-HRD) logbooks are supported via a DDE interface (see DDE Support 

on page 61) and a serial port (see 3
rd

-Party Programs on page 149). So you can 

use the logbook of your choice with HRD provided it supports DDE or the 

Kenwood protocol via a COM port. 

Database 

The database engine originally used was DAO; this was replaced in early 2006 

with ODBC, as DAO is not supported on 64-bit Windows systems. 

The driver used is the Microsoft Access Driver (*.mdb) ODBC driver. If you do 

not have the Microsoft Access Driver (*.mdb) ODBC driver on your system then 

download the latest Jet 4.0 files from www.microsoft.com . 

See also: 

How to obtain the latest service pack for the Microsoft Jet 4.0 Database Engine 

http://support.microsoft.com/default.aspx?kbid=239114 . 

INFO: How to Install ODBC Components and Drivers 

http://support.microsoft.com/default.aspx?scid=kb;en-us;313008 

Refer to Annex: Logbook Database on page 173 for details of the database 

design. 

Starting 

There are two logbook windows: 

1. Main, 

2. Small. 

The main display is a standard full-blown logbook; the small display has a fixed 

set of fields and a simple QSO entry area. 

Select the default display from the Logbook menu. 

 

http://www.microsoft.com/
http://support.microsoft.com/default.aspx?kbid=239114
http://support.microsoft.com/default.aspx?scid=kb;en-us;313008


Small Display 

As you see in the picture below, the small display is very simple. 

The window can be docked to the top or bottom of the main HRD display and 

used at the same time as the radio display. 

 

The display lists the 100 most recent QSO‟s. The options are: 

 Add an entry using the advanced logbook entry window. 

 Show main logbook window. 

 Edit selected entry. 

 Logbook options. 

 Delete the selected entries. 

 Show or  Hide the input fields. 

Input Fields 

When you press  the input fields are displayed. 

 

Just enter the QSO information, then press  . 

Pressing  loads the current time into the appropriate field. Pressing  displays 

the options window where you select whether the Frequency and Mode fields 

track the values shown in the radio display. 

 

Main Display 

The main display has a more traditional logbook approach. 
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When you start HRD a default logbook is created in the default files folder, see 

Files on page 84. 

Options 

 Select the database – if the file you select does not exist then a new 

database is created. 

 If selected then changes in the selection fields (below) are applied 

immediately, if not checked you must press Apply. 

 Press to apply changes made in the selection fields, only enabled if 

 is checked. 

 

Selection fields: 

 

Select the entries that are displayed: 

Entries – the maximum displayed in the main list. The fewer you display the 

faster they are loaded. The maximum you can display is 25,000 – if you have 

more than 25,000 entries in your database then only the first 25,000 that match 

the selection criteria are displayed. 

Date – display entries since this date. Typically you will only display entries 

from the last few days. 

Filter – filter by any field (except dates) – for example mode or callsign. Check 

Exact for an exact match. 

Summarise – display the first entry that matches the selection. For example, if 

you select Country and Band you see the first entry for each country and band. 

Sort – select the sort criteria (alternatively click the column headers). 

 



 Print the logbook (page 90). Select Print Setup from the File menu to select 

paper size, layout, etc. Use Print Preview first to see what it will look like. 

 Print preview – see what your logbook looks like before you print it. Print 

preview can be very CPU intensive with a large logbook (25,000 or more 

entries) so be prepared to wait a few seconds before it starts drawing. 

 Add a new entry (page 76). 

 Edit the currently selected entry. 

 Delete the selected entries. 

 Start the logbook analyser. 

 Plot selected entries using Mapper. To be plotted an entry must have a 

valid locator. 

 Reload the database and refresh the display. 

 Auto fit the column widths to their contents. 

 Define column layout. 

 Backup the database. 

 Database configuration. 

 Lookup station using QRZ.com . 

 Plot station locations using Google Earth. 

Adding An Entry 
Select Add Entry from the Logbook menu. Here you see many more fields than 

those in a paper logbook; only a few are mandatory. 

The entry window is divided into two sections: Main and Tabbed (for want of a 

better description). 

The Main section contains the frequently used fields whereas the Tabbed section 

contains the less-frequently used fields. 

Main 

http://www.qrz.com/
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The buttons  and  respectively hide and show the tabbed fields, ideal for 

simple contest operation when you want the minimum of visual „noise‟. 

 

Field Description 

Start The QSO start date and time. With the Options you can: 

 automatically set the start (and end) time to the current time when 
pressing the Reset button, and 

 Set the start time when a callsign is entered in the Station field 
(the time is set when the Station field loses focus). 

End The end time. The date is taken from the start date, if the end time is less 

than the start time then it is assumed that the QSO ends on the next day. 

With the Options you can: 

 automatically set the end (and start) time to the current time when 
pressing the Reset button, 

 set the end time when you add the QSO. 

Station The callsign of the other station. 

QRZ Press QRZ to retrieve information from QRZ.com (see below). 

RST 

Recv 

The report received from the other station. With the Options you can select 

the default value (if any) entered in this field when you press Reset. 

RST 

Sent 

The report sent to the other station. This field is divided into two parts: 

1. the RST sent, and 

2. the additional information sent, for example a serial number.  

With the Options you can select that the RST sent count is automatically 

incremented. 

Locator Maidenhead locator square. If a valid 4-character (major) or 6-character 

(minor) square the distance and bearing from you locator in the My Station 

tab is shown. 

Filled in by you or via a QRZ.com lookup. 

Name The other station‟s name, filled in by you or via a QRZ.com lookup. 

Remark Whatever you want; filled in by you or via a QRZ.com lookup. 

Mode The mode – if you enable the option track radio mode then the value here is 

taken from the HRD display. If this option is not enabled then pressing  
loads the current HRD mode. 

Band The band – determined from the HRD frequency is the option track radio 

frequency is enabled. If this option is not enabled then pressing  loads the 

current HRD band. 



Freq The frequency – determined from the HRD frequency is the option track 

radio frequency is enabled. If this option is not enabled then pressing  
loads the current HRD frequency. 

[X] Freq: Make sure this checkbox is checked otherwise the frequency is not 

added. 

Cnty Country – selected from the dropdown list or determined automatically if the 

option find callsign from callsign prefix is enabled. 

[X] Cntry: Make sure this checkbox is checked otherwise the country is not 

added. 

IOTA Islands on the Air - http://www.rsgbiota.org/ . 

Address The address field, filled in by you or via a QRZ.com lookup. 

QTH The station location, as in „my QTH is…‟. Filled in by you or via a 
QRZ.com lookup. 

 

QRZ.com 

An excellent Internet resource, http://www.qrz.com/ is used by HRD to find 

station information. The fields supported are shown below. HRD extracts 

information by parsing the detail field for a station, for example 

http://www.qrz.com/detail/HB9DRV . 

In the Options window you can enable automatic QRZ lookups. 

 

 

Log 

 

 

Field Description 

http://www.rsgbiota.org/
http://www.qrz.com/
http://www.qrz.com/detail/HB9DRV
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Last 100 Shows the most recent 100 entries from the logbook. 

Partial match List the most recent 100 entries from the logbook that partially match 

the currently entered callsign. 

Exact match List the most recent 100 entries from the logbook that match the 

currently entered callsign. 

 

Contact 

 

More information about the station you have contacted. 

 

Field Description 

SIG The name of the contacted station‟s special activity or interest group. 

SIG info Information associated with the contacted station's activity or interest group. 

10-10 Ten-Ten number 

 

Location 

 

 

Field Description 

County The contacted station's Secondary Administrative Subdivision of 

contacted station (e.g. US county, JA Gun). 

State/province The code for the contacted station's Primary Administrative 

Subdivision (e.g. US State, JA Island, VE Province). 

ARRL sect The contacted station's ARRL section. 

CQ zone The contacted station‟s CQ Zone. 

ITU zone The contacted station‟s ITU zone. 

Distance The distance between the logging station and the contacted station in 

kilometers. 

Lat/Lon The contacted station‟s latitude and longitude. Press  to determine 

the latitude and longitude from the Locator field value in the Main part 
of the window. 

 

QSL 

http://f3.grp.yahoofs.com/v1/ILL4QyIAHIplEKOdm7OVR5qxLlRFfROdk1C8RH2SD2UJ7Ct7IEHk34G-Gnjye0G66Y4C7MXDam_TpYC6KpWtVQOePW3i6Fs9jU4/ADIF%20217.htm#CALL
http://f3.grp.yahoofs.com/v1/ILL4QyIAHIplEKOdm7OVR5qxLlRFfROdk1C8RH2SD2UJ7Ct7IEHk34G-Gnjye0G66Y4C7MXDam_TpYC6KpWtVQOePW3i6Fs9jU4/ADIF%20217.htm#CALL
http://www.arrl.org/sections/


 

Standard QSL information. 

 

eQSL 

 

Not supported by ADIF, these are fields for use with eQSL.cc . 

 

Field Description 

eQSL status Status of the most recent upload. 

eQSL user Logon username 

eQSL pwd Logon password 

eQSL.cc real-time 

uploads 

If checked then an upload is made every time you add a QSO. 

This is also known as real-time uploads. 

 

Ant/Sat 

 

 

Field Description 

Azimuth The logging station's antenna azimuth, in degrees. 

Elevation The logging station's antenna elevation, in degrees. 

Path The signal path. 

Name Name of satellite. 

Mode Satellite mode. 

 

Contest 

http://www.eqsl.cc/
http://f3.grp.yahoofs.com/v1/ILL4QyIAHIplEKOdm7OVR5qxLlRFfROdk1C8RH2SD2UJ7Ct7IEHk34G-Gnjye0G66Y4C7MXDam_TpYC6KpWtVQOePW3i6Fs9jU4/ADIF%20217.htm#STATION_CALLSIGN
http://f3.grp.yahoofs.com/v1/ILL4QyIAHIplEKOdm7OVR5qxLlRFfROdk1C8RH2SD2UJ7Ct7IEHk34G-Gnjye0G66Y4C7MXDam_TpYC6KpWtVQOePW3i6Fs9jU4/ADIF%20217.htm#STATION_CALLSIGN
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If you check [X] reset fields after adding an entry then the fields are erased 

when an entry is added. If not checked then the fields are not erased. 

 

Field Description 

Check Contest check (e.g. for ARRL Sweepstakes). 

Class Contest class (e.g. for ARRL Field Day). 

Precedence Contest precedence (e.g. for ARRL Sweepstakes). 

Contest QSO Contest Identifier. 

 

Propagation 

 

Basic propagation information, press WWV Download to load the latest 

information from http://www.sec.noaa.gov/ftpdir/latest/wwv.txt. 

 

Field Description 

A index The geomagnetic A index at the time of the QSO. 

K index The geomagnetic K index at the time of the QSO. 

Solar flux The solar flux at the time of the QSO. 

MS 

shower 

For Meteor Scatter QSO‟s, the name of the meteor shower in progress. 

Num 

bursts 

The number of meteor scatter bursts heard by the logging station. 

Num pings The number of meteor scatter pings heard by the logging station. 

Max 

bursts 

Maximum length of meteor scatter bursts heard by the logging station, in 

seconds. 

Prop mode QSO propagation mode. 

 

My Station 

http://www.sec.noaa.gov/ftpdir/latest/wwv.txt


 

A description of your station at the time of the QSO. These fields are the same as 

those in My Station on page 85. 

Select a profile by pressing the corresponding button; press Save to save any 

changes you make. 

 

Field Description 

Callsign The logging station's callsign (the callsign used over the air). 

Operator The logging operator's callsign. 

Owner The callsign of the owner of the station used to log the contact (the 

callsign of the Operator‟s host). 

SIG The logging station‟s special activity or interest group. 

SIG info Information associated with the logging station's activity or interest group. 

 

Custom 

 

Here are six totally customisable fields, use them as you wish. If you check [X] 

reset fields after adding an entry then the fields are erased when an entry is 

added. If not checked then the fields are not erased; the values are stored in the 

registry and loaded the next time you start HRD. 

http://f3.grp.yahoofs.com/v1/ILL4QyIAHIplEKOdm7OVR5qxLlRFfROdk1C8RH2SD2UJ7Ct7IEHk34G-Gnjye0G66Y4C7MXDam_TpYC6KpWtVQOePW3i6Fs9jU4/ADIF%20217.htm#OPERATOR
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Options 

 

 

Logbook Fields 

Select the fields that are displayed – reduce clutter during a contest when you 

only want the bare minimum. 

Appearance 

The current S-Meter and date/time are shown at the top of the window; remove 

these if you don‟t want them. 

Reset (Add Only) 

Select what happens when you press Reset or when you add a new QSO and the 

[X] Reset fields… option is checked. 

Layout Size (Restart Required) 

For tired eyes – set the window size to Small, Medium or Large. You must reset 

HRD for the change to take effect. 

Reset (Add Only) 

Select what happens when you press Reset or when you add a new QSO and the 

[X] Reset fields… option is checked. 

Start / End Times (Add Only) 

As part of the QSO automation enable these options to set the start time when 

you first move out of the Station field and the end time when you add the QSO. 

Note – the start time is not updated if you edit the callsign. It is set only when 

you move out of the Station field for the first time. 

Behaviour (Add Only) 

During a contest you will want to auto-increment the RST sent counter – the first 

numeric part of the RST sent field is updated, for example 042GR is updated to 

043GR. 

The country is determined from the callsign prefix using the logbook‟s country 

data (List - Countries on page 87). 

Audio Grabber (Add Only) 

Enable display of the Audio Grabber so that a new audio file is created for each 

QSO. 

QRZ (Add Only) 



QRZ.com is an excellent resource – here you enable automatic lookups. 

Database Configuration 

Here you control many aspects of the logbook. 

 Configuration is selected from the Logbook menu or the configuration 

toolbar button. 

Files 

 

The current database file‟s size and location are displayed. 

 Selects a new database, this is created if it does not exist. 

 Moves the database to a new folder. 

 Select the folder where backups are stored when you press the Backup 

button in the logbook toolbar (remember to take regular backups). 

Appearance 
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Adjust the appearance of the display to suit your own taste. Using alternate 

colours makes reading copious data much easier. Using a larger font helps with 

tired eyes 

My Station 

 

Optional information about your station – equipment and location. 

You have 10 profiles. 

Custom Fields 

 

Define the titles for the six custom fields available in the logbook windows. Use 

these fields for values not supported elsewhere. 



Various 

 

The options here should be self-explanatory.  

List – Bands 

 

The band ranges. This information is taken from the ADIF specifications; it is 

used to determine the correct band from a frequency. 

 Resets the table and loads the latest values built into HRD. 

 Display this data with the default text file viewer. 
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List - Countries 

 

The data used to determine country from the callsign prefix. 

 Resets the table and loads the latest values built into HRD. 

 Display this data with the default text file viewer. 

 Loads new data from a text file. 

 Browse the web for a new countries file, default URL is 

ftp://www.ham-radio.ch/countries/ . 

 Update logbook entries with the latest countries file data. 

 

ftp://www.ham-radio.ch/countries/


List – Modes 

 

The supported modes; this information is taken from the ADIF specifications. 

 Resets the table and loads the latest values built into HRD. 

 Display this data with the default text file viewer. 

List – QRZ Cache 

 

QRZ.com is an invaluable resource; HRD supports callsign lookups using 

QRZ.com in the DX cluster and logbook. 

A cache is maintained of data retrieved from QRZ.com. Data is taken from the 

cache unless the user of HRD selects the refresh option when viewing QRZ.com 

data. 
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 Resets the table and loads the latest values built into HRD. 

 Display this data with the default text file viewer. 

 Refresh this window. 

Logfile 

 

All database activity since starting HRD. 

Analysis 

The logbook does not have an award tracker as such; there are so many awards 

available you could spend all your time just filling in the forms and submitting 

your QSL cards. 

To help you see what you have achieved use the Analysis option . 

You define the criteria for one or more analysis configurations; the database 

contents are compared to each configuration and the results are displayed in the 

analysis window. 

 

The logbook entries that match the configuration selected in the top half of the 

analysis window are shown in the bottom half of the window. 



 

 

Printing 

There‟s nothing better than a paper log for reviewing your on-air achievements. 

Before you select the Print option  you should first use the Preview option  

to review what you will be printing before committing another rain forest to the 

recycling bucket! 

 

When you select Print or Preview the Print Options window is displayed. 

When reviewing a contest or QSO‟s selected for an award you will usually 

enable the QSO counter option. 

The alternate background option makes the log easier to read (just try it), adding 

blank lines between days is very much a personal preference. 
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Import / Export 

All logbooks must support the import and export of entries; HRD‟s logbook is 

no exception to this rule. 

Import 

You can import from ADIF and also merge another HRD logbook database. 

To import an ADIF file select Import from ADIF from the Logbook menu. You 

are prompted to select an ADIF file (*.AID, *.ADF, *.ADIF or *.TXT). When 

you have select the file to be imported the Import from ADIF window is 

displayed. 

Check [_] Compute band from frequency to fill in the band field from the 

frequency field. 

Check [_] Compute DXCC from callsign if DXCC field missing to automatically 

determine the corresponding DXCC value. 

Press  to load the file into memory. The contents are analysed and 

displayed. 



 

Now press  to save the displayed entries in your database. 

Export to ADIF 

Select Export to ADIF from the Logbook menu, the Export to AIDF window is 

displayed. 

 

Select the fields and entries to be exported. 

If you are only uploading to the ARRL‟s Logbook of The World then there is no 

need to export unnecessary fields – this just makes the whole LoTW experience 

slower.  
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Similarly if you are uploading to eQSL there is no need to upload unnecessary 

data. 

ADIF files can be viewed with any text reader such as Notepad, an example of 

an eQSL export is shown below. 

 

Export to Cabrillo 

Why Cabrillo? From the Cabrillo FAQ: „Cabrillo is an interface between logging 

program authors and contest sponsors.  It is a simple and practical modification 

to the ARRL electronic log format, intended to simplify the automation of log 

collecting and reporting of contest results.‟ 

In reality supporting Cabrillo is a pain in the neck for any programmer with even 

the remotest grasp on reality. Let‟s hope that the ARRL and other sponsors of 

Cabrillo move towards a better standard such as XML. 

The Cabrillo website is http://www.kkn.net/~trey/cabrillo/. 

Here‟s the HRD Export to Cabrillo window. At present HRD does not support 

all the Cabrillo formats. 

 

http://www.kkn.net/~trey/cabrillo/


Problems 

Performance 

If you find that the database is exceptionally slow make sure that ODBC tracing 

is switched off. 

From the Start menu select Settings / Control Panel / Administrative Tools / 

ODBC Data Source Administrator select Tracing. Here you stop tracing (if 

started). 

 

Errors 

If you get problems using the Logbook – for example a window such as: 

 

then follow the steps below to generate a trace file which provides all 

information required to diagnose the problem. 

1. Close HRD. 

2. From the Start menu select Settings / Control Panel / Administrative 

Tools / ODBC Data Source Administrator select Tracing. 

3. Press Start Tracing Now. 

4. Start HRD, open the Logbook, and perform the steps necessary to 

generate the error. 

5. Stop tracing. 

6. Save the logfile to a ZIP archive and forward to the HRD developers. 
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K1EL WinKey 

Introduction 

“WinKey brings high functionality, fully featured Morse keying to logging 

applications. Although designed for Windows-based software implementation, 

WinKey can add value to all logging programs regardless of operating system or 

platform. Can also be used as a stand-alone keyer.”  

Source: http://www.k1el.com/ 

A lot of the description of the WinKey support is taken from the WinKey 

documentation, copyright K1EL. 

 

     

(Photos from http://www.k1el.com/) 

 

K1EL‟s WinKey is an excellent computer controllable keyer solution. It supports 

everything a CW enthusiast could want. Many computer programs support 

WinKey; here is a description of the HRD support. 

You will need a standard 9-pin serial cable (not NULL-modem). 

Main Window 
Select K1EL WinKey from the Tools menu, the WinKey window is displayed. 

 

http://www.k1el.com/
http://www.k1el.com/


Here the user is sending text at 12 wpm – the speed is adjusted with the slider in 

the top-left. If Repeat is checked the text is retransmitted after a user-

configurable value between 2 to 60 seconds, in this example 5 seconds. 

Text is entered using the keyboard; only the allowable CW characters can be 

entered. 

Macros are selected by double-clicking on an entry in the macros list or by using 

an accelerator key combination such as Ctrl+1. 

Press F2 to start sending. 

 

Characters sent to the keyer are marked with the strikethrough effect. Characters 

sent by the keyer to the radio are displayed at the bottom of the window. 

Press F1 to mark sent text as unsent, F3 to erase the contents of the window. 

Options 
Press the Options button (F8) to display the Options window. As an intelligent 

owner of the WinKey you will have studied the available literature, so some of 

the information here should be obvious. But in case you have forgotten 

something… 

Keyer 

 

Select the type of keyer and the COM port to which the keyer is connected.  

When you press Connect the keyer is initialized and an echo-back test 

performed. The test must succeed for the connection to stay open. This ensures 

that you have not accidentally connected to another device such as a rotator, 

which may have a fit if driven by the WinKey protocol! 

A sample log for a successful connect: 
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Autospace 

If you pause for more than one dit time between a dit or dah WinKey will 

interpret this as a letter-space and will not send the next dit or dah until full 

letter-space time has been met. 

The normal letter-space is 3 dit spaces. WinKey has a paddle event memory so 

that you can enter dits or dahs during the inter-letter space and WinKey will send 

them as they were entered. With a little practice, autospace will help you to send 

near perfect Morse. 

Contest Spacing 

Reduces the wordspace time by one dit. Instead of 7 dits per wordspace, contest 

spacing selects six dits per wordspace. 

Paddle Echoback 

When enabled all characters entered on the paddles will be echoed back to the 

host. From the host perspective paddle echo and serial echo are the same, in 

either case the letter sent in Morse by WinKey is echoed back to the host. The 

echo occurs after the letter has been completely sent. 

Paddle Watchdog 

The paddle watchdog counter disables the key output after 128 consecutive dits 

or dahs. This is to guard against the paddles being accidentally keyed 

continuously. 

Swap Paddles 

Allows right- and left-handed operators to share the same keyer. 

Serial Echoback 

Echo back is a feature that is included to allow a host application to stay exactly 

in sync with Morse letters sent. When this mode is enabled all data taken out of 

the serial buffer is sent to the host after it has been sent in Morse. This allows the 

host to reconcile differences in timing introduced by WinKey‟s internal 32-byte 

serial buffer. Note that only letters, and not buffered commands with their 

parameters or wordspaces, are echoed back to the host. 

 

 



Speeds 

 

With Keyer min and Keyer max you set the range available in the WinKey main 

window. 

Similarly with Speed pot min and Speed pot max you set the range available 

with the potentiometer mounted on the top of the WinKey enclosure. 

Farnsworth speed is the speed at which characters are actually sent.  

Options 

 

These options define the shape of the transmitted signal. 

Ist Extension 

This addresses a problem often encountered when keying older transceivers that 

have a slow break-in response. Due to a slow receive to transmit changeover 

time, the first dit or dah of a letter sequence can be chopped and reduced in 

length. Adding a fixed amount to the first element of a sequence can compensate 

for this. For example, an R would be sent with the first dit elongated but the 

subsequent dah-dit sent normally. The compensation amount is transceiver 

dependent and is generally independent of sending speed. Note though that this 

is usually only a noticeable problem at higher CW speeds >25 WPM. 

Compensation 

This allows a fixed amount to be added to the length of all dits and dahs. QSK 

keying on modern transceivers can cause shortening of the dit and dah elements 

that is especially noticeable at high speeds. WinKey allows the length of the dit 

and dah elements to be increased uniformly to compensate for this. The 

adjustments are made in units of one-millisecond steps. The maximum 

adjustment is 250 msecs. 

Key compensation is very similar to Weighting in that any adjustment added to 

the dits and dahs is subtracted from the spacing so the speed is not changed. The 

difference between weighting and compensation is that compensation is 

independent of speed, so if 10 msec of key compensation is selected 10 msec 
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will be always be added regardless of speed. So be careful at high speeds and 

large values of key compensation, you may end up with no inter-element space. 

Switchpoint 

Controls when WinKey will start looking for a new paddle press after sensing 

the current one. If there is not enough delay the keyer will send unwanted dits or 

dahs, if there is too much delay it bogs you down because you can't get ahead of 

the keyer. The default value is one dit time (50) and is adjustable in percent of a 

dit time. Faster operators report a setting somewhat less than default is more 

pleasing. If the paddle sensitivity is set to zero, dit and dah paddle memory is 

disabled. The delay is calculated with this formula: 

DELAY_TIME = (SWITCHPOINT * DIT_TIME)/50 

where SWITCHPOINT is a value between 10 and 90. 

Dit : Dah Ratio 

Allows WinKey to deviate from the standard 1:3 ratio of dit/dah. The formula to 

determine dah/dit ratio is: 

DAH/DIT = 3.(nn/50) 

A value of 50 selects 1:3, a value of 33 would select 1:2, and a value of 66 

would select 1:4. This causes an intentional distortion of the Morse waveform. 

Some ops use this option to make their CW sound less „machine like‟. 

Weighting 

This command allows a proportional amount to be either added or subtracted 

from the length of all dits and dahs sent. A value of 50 selects no weighting 

adjustment. Values less than 50 reduce weighting and values greater than 50 

increase weighting. Note that weighting does not affect sending speed because 

any increase in keyed time is subtracted from spacing time. A reduction in 

weighting results in a thinner sounding keying; increased weighting results in a 

heavier sound. Since weighting tracks speed, a given weighting will sound the 

same at all speeds. 

PPT Lead / PTT Tail 

WinKey provides a transmitter PTT output that can be used to switch a 

transmitter or linear amplifier over to transmit mode in advance of actual CW 

keying. You have control over the time delay between when PTT is asserted and 

when CW keying will start, this is lead-in. You also have control over how long 

the transmitter will stay in transmit after keying has stopped; this is the tail 

delay. 

Note: PTT pin 5 can be reconfigured as a sidetone output, see Sidetone 

Frequency option. 

Sidetone 

Pin 5 can be configured to output a square wave sidetone by using the Set Pin 5 

Mode option. When sidetone is enabled, pin 5 functions as a sidetone square 

wave output. The PTT delays still work as described by the Set PTT Lead/Tail 

Command, but a PTT output is not available. 

Available sidetone frequencies are: 3759 Hz, 1879 Hz, 1252 Hz, 940 Hz, 752 

Hz, 625 Hz, 535 Hz, 469 Hz, 417 Hz, 375 Hz. 



Pin Config 

 

Determines how the output pins are mapped. 

Macros 

 

Define an unlimited number of macros that can be selected in the WinKey main 

window. 

Logfile 

 

To help diagnose problems use the Logfile window. The Viewer option displays 

the contents of the window in your default text file (.txt) editor. If you check 

Trace then all traffic over the COM port is logged. 
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Help 

 

Some basic help text; specifically the Prosign key assignments. 

Prosign Assignments 

" RR  / DN 

$ SX  : KN 

' WG  ; AA 

( KN  < AR 

) KK  = BT 

+ AR  > SK 

- DU  @ AC
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Macros 

Introduction 

HRD supports two types of custom definitions: 

 CAT commands, and  

 Combinations of standard HRD input fields. 

Macros are selected from the Macros pane in the Selection window. 

CAT Commands 

A CAT command macro is a command that you define yourself, containing one 

CAT commands as describer in your radio‟s handbook. The commands you 

enter must be supported by your radio. 

Use CAT commands to add support not provided by the HRD interface. 

Manager 

Either press Manager in the Macros> CAT Commands pane or select CAT 

Command Manager from the Macros menu. 

 

Press New to create a new command definition. 



In this example a Kenwood command is defined for the TS-480. The mode is set 

to USB and the frequency to 50.150 MHz. 

In the Title field enter ‟50.150 MHz USB‟. 

In the CAT Command field enter: 

# Set mode to USB. 

MD2 

# Set frequency to 50.150 MHz 

FA00050150000 

In the Description field enter „Change frequency to 50.150 MHz, mode to USB‟. 

 

Now press OK. The new definition is added to the list in the Manager window. 

Protocols 

Elecraft and Kenwood 

Each command consists of 2 alphabetical characters (lower or upper case) and 

optional parameters. Please read your operating manual for command 

information. 

The terminating semicolon (;) is not necessary, it is added automatically. 

TS-480 

Set mode to LSB .....: MD1 

Set mode to USB .....: MD2 

Set AF gain to 0 ....: AG0000 

Set AF gain to 100 ..: AG0100 

Select VFO-B ........: FT1 

You can define more than one command; to do this start each command on a 

new line. 

Special Commands 
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Comment ..........: # Some interesting text. 

Pause of 250 ms ..: @ 250 

ICOM 

ICOM radios use the CI-V format to communicate with the radio. Please read 

your operating manual for command information. 

Each entry defined here consists of: 

 [1] command, 

 [2] optional sub-command and 

 [3] optional data. 

You must add a - between each byte (each byte is two hexadecimal characters). 

IC-7800 

Set mode to LSB ..........: 06-00 

Set mode to USB ..........: 06-01 

Set AF to 0 ..............: 14-01-00 

Select preamp 2 ..........: 16-02-02 

MOD I/P (data off) MIC ...: 1A-05-00-31-00 

MOD I/P (data off) SPDIF .: 1A-05-00-31-07 

You can define more than one command; to do this start each command on a 

new line. 

Special Commands 

Comment ..........: # Some interesting text. 

Pause of 250 ms ..: @ 250 

Ten-Tec 

In general Ten-Tec commands are two character commands followed by data 

and a carriage return <cr> or <0x0d>. Do NOT add the carriage return - this is 

added automatically. 

Some data must be sent in binary format, hexadecimal is used to represent binary 

data. To set Split mode on for the Argonaut the documented command is 

*O<0x01><0x0d> which is entered here as *Ox01, that is *O (Split mode) + x 

(switch to binary) + 01 (Split On). The carriage return <0x0d> is not added. 

Please read your operating manual for command information. 

When you enter x the format switches to binary mode - two hexadecimal 

characters per byte. Only enter x once, even if entering more than one byte of 

data. 

Argonaut 

Set mode to LSB .....: *M2 

Set mode to USB .....: *M1 

Set split mode on ...: *Ox01 

Set split mode off ..: *Ox00 

Jupiter 

Set mode to LSB .....: *M2 

Set mode to USB .....: *M1 

Set AF gain to 32 ...: *Ux20 

Set filter to 450Hz .: *Wx1D 

You can define more than one command; to do this start each command on a 

new line. 



Special Commands 

Comment ..........: # Some interesting text. 

Pause of 250 ms ..: @ 250 

Yaesu 

Starting with the FTDX-9000 Yaesu has changed the CAT protocol to one very 

similar to that used by Kenwood. So if you are fortunate enough to have the 

FTDX-9000 please use the Kenwood commands – see Elecraft and Kenwood on 

page 104. 

Each Yaesu command consists of five bytes. The bytes are defined in the order 

in which they are sent to the radio. You must add a - between each byte. 

Each command consists of four bytes of data and an OpCode. The order in 

which P1-P4 are shown in your operating manual does not matter here - there are 

difference between Yaesu radios, just remember that the bytes are defined in the 

order in which they are sent to the radio. Please read your operating manual for 

command information. 

FT-817 

Set mode to LSB ..: 00-00-00-00-07 

Set mode to USB ..: 01-00-00-00-07 

Split on .........: 00-00-00-00-02 

FT-1000MP 

Set mode to LSB ..: 00-00-00-00-0C 

Set mode to USB ..: 00-00-00-01-0C 

Split on .........: 00-00-00-01-01 

You can define more than one command; to do this start each command on a 

new line. 

Special Commands 

Comment ..........: # Some interesting text. 

Pause of 250 ms ..: @ 250 

Input Fields 
Input field macros are combinations of fields on the HRD radio display. Users of 

Microsoft Office will be familiar with the concept supported here. 

Manager 

Select Macros Manager from the Macros menu, and then press New to create a 

new macro. This macro will switch your radio to 50.150 MHz in USB. 

First we will set the mode to USB:  

 In the Title field enter „50.150 MHz USB‟. 

 In the Group field enter „Macros: Simple‟. 

 In the Description field enter „Change frequency to 50.150 MHz, 

mode to USB‟. 
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 Press Add to select Dropdown Button Mode: USB 

 

 

 Press OK. 

Now set the frequency to 50.150.000: 

 Press Add to select Frequency 50.150.000 MHz. 

 

 

 Press OK. 

Your definition now contains two entries: 

 

Press Save, this returns you to the Macros Manager. 



 

Press OK. The window closes; the Macros sub-pane Macros: Simple now 

contains your new macro. 

 

Snapshots 

The snapshot button creates a definition that contains the state of all input fields. 

This is an easy way of preserving a known state of your radio once you have set 

it up exactly the way you want.



 Quick Save    109 

Quick Save 

Introduction 

This is a simple way of marking a frequency as being interesting – you are 

monitoring three QSO‟s with a single radio and you want to quickly switch 

between the frequencies – for example during a 6m sporadic-E opening. 

Each definition consists of the frequency in Hertz and mode; definitions are 

saved in the registry. 

To switch between Quick Save definitions use the accelerator key combinations 

for the Quick Save menu options Next (Ctrl+F5) and Previous (Ctrl+F6). 

Add Entry 

Select Add from the Quick Save menu or just click the Quick Save button. 

 

An entry is added to the Quick Save pane in the Selection window. 

Markers 

To display markers in the HRD display select Show Markers from the Quick 

Save menu. The marker size is selected from the Marker Size option in the Quick 

Save menu. 

 

The popup text is displayed as you move the mouse pointer over a marker. The 

text is constructed from the frequency and mode.
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Remote Station Support 

Introduction 

HRD is evolving into a program that supports all the serial port-enabled devices 

that you control at your remote station. 

For radio control you use the HRD Remote Server. For other devices such as 

keyers and rotators you use the HRD Serial Port server. Note that the HRD 

Remote Server is highly optimized for use with HRD and should be used to 

control the radio. 

The HRD Serial Port Server enables a connection between Ham Radio Deluxe 

and serial port-enabled devices (keyers, rotators) connected to a remote 

computer that can be contacted via TCP/IP. 

Requirements 

The remote computer must be running Windows NT – that is NT 4.0, 2000, 2003 

or XP. Windows 95, 98 and various flavours thereof are not supported. 

Technology 

A Windows service is installed on the remote service. This listens on a port 

(usually 7805) for incoming connections from Ham Radio Deluxe (the client). 

For more technical information see Annex: Remote Server on page 167. 

IP Address 

If you are installing on a remote computer then the computer must have a static 

(non-changing) public IP address. If you have a public IP address which is not 

static then visit http://www.no-ip.com/ and use the free IP redirection option. 

Firewall 

Make sure you open up ports 7805 (HRD Remote Server) and 7806 (HRD Serial 

Port server) for incoming TCP traffic. The port assignments can be changed in 

the configuration files. 

http://www.no-ip.com/


Example 

 

In this example the remote station uses serial ports as follows: 

 COM1  IC-7800, 

 COM4  WinKey keyer, 

 COM6  AlfaSpid rotator. 

Two virtual null modem „cables‟ are installed (pure software, no hardware 

involved). The vCOM driver from N8VB is highly recommended; see 

http://www.philcovington.com/SDR.html . To install the vCOM drivers see 

Annex: N8VB vCOM on page 163. 

In this example the „cables‟ map ports as follows: 

 COM20  COM21, and 

 COM22  COM23. 

The local station connects as follows: 

IC-7800 

Remote port selected, TCP/IP connection made with the HRD Remote Server 

running on the remote computer (port 7805). 

The HRD Remote Server connects to the IC-7800 using COM1. 

Keyer 

The HRD Winkey interface connects to the HRD Serial Port client on the local 

computer using the COM20  COM21 virtual cable. 

The HRD Serial Port client connects to the HRD Serial Port server on the remote 

computer using TCP/IP (port 7806). 

The HRD Serial Port server connects to the K1EL WinKey using COM4. 

http://www.philcovington.com/SDR.html
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Rotator 

The HRD Rotator interface connects to the HRD Serial Port client on the local 

computer using the COM22  COM23 virtual cable. 

The HRD Serial Port client connects to the HRD Serial Port server on the remote 

computer using TCP/IP (port 7806). 

The HRD Serial Port server connects to the AlfaSpid rotator using COM6. 

Virtual Null Modem Software 

The vCOM driver from N8VB is highly recommended; see 

http://www.philcovington.com/SDR.html . 

This is the same as a null modem cable except it is made using software. The 

vCOM software supports up to 10 cables. Each cable is allocated two COM 

ports. 

You simply connect HRD to one end and the HRD Serial Port Client to the 

other. 

To install the vCOM drivers see Annex: N8VB vCOM on page 163. 

HRD Remote Server 

Installing 

The HRD Remote Server files are: 

 HRDRemoteSvr.exe – the executable, and 

 HRDRemoteSvr.cfg – configuration file. 

To install the service select Remote Service from the Tools> Programs menu. 

 

 

Press HRD Remote Server to select this server. 

http://www.philcovington.com/SDR.html


Press Install to install the service, and then press Start to start the service. 

You can start the Windows Services applet (Start – Settings – Control Panel – 

Administrative Tools – Services) to modify the properties of the service, for 

example disabling automatic startup. 

 

Firewall 

Allow incoming connections on port 7805. 

Configuring 

Press Configure to edit HRDRemoteSvr.cfg that contains the service 

configuration. 
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The contents of this file should be obvious. After changing the configuration you 

should restart the service. 

Restricting TX 

One special note – to restrict a user‟s ability to switch the radio to transmit there 

are now optional tokens added with the username and password to disable access 

to the TX and any Tune buttons. 

In addition you will want to disable macros as a knowledgeable user can define a 

CAT command to enable TX. 

Enable Restart 

The RESTART token enables the Restart button on the connection window. 

Restarting the service will close all COM ports opened by the service and drop 

all connections by HRD users. 

This should only be allocated to yourself and your friends! 

Connecting 

To connect to the remote server enter values as normal when starting HRD but 

select the Remote port, then press Connect. 



 

When you press Connect the Remote Connection window is displayed. 

 

 

Enter connection information: 

 Address: the remote computer address in either numeric or alphabetic 

form – for example 195.154.179.101 or www.simon-home.ch . 

 Port: the port assigned to the remote service, usually 7805. 

 Username: a valid username defined in the configuration file. This is 

case-insensitive. 

 Password: the password corresponding to the username. This is case-

insensitive. 

 To save these values make sure the Save settings option is checked [X]. 

 

 Load connection information from a file. 

 Save connection information to a file. 

 Press Connect. If the connection is successful you see the 

confirmation window 
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and the text Username/password authenticated. Select a remote COM port, then 

press ‘OK’ is displayed below the Connect button. 

 

 

Now select the COM port, and then press OK to connect to the remote COM 

port and start the HRD radio display. 

When the connection with the radio has been confirmed a Remote Connection 

display window shows you the data throughput and average round-trip time. 

  

Remote Connection 

 

Use the Remote Connection window to show the status of the remote connection. 

 Round-trip time: the time required to send a message from HRD to 

the remote server and get a response. This will be very similar to 



the value shown when you use Ping to interrogate a remote host. 

Typically values of 50 milliseconds or less are very usable. 

 Refresh interval: the interval between refreshes of the selected 

Regularly Read options. 

 Send frequency: when the frequency is updated over a link with a 

high round trip time (> 100ms) the performance will be less than 

optimal with Sync selected so if the round trip is high select Async, 

otherwise just select Sync. The disadvantage of using Async is an 

'elastic band' effect while tuning by dragging HRD's small tuning 

marker.  

 Regularly Read: the options that are regularly updated. If you are 

using a fast link - for example to a local station with a low round-

trip time then you can safely select all options. The disadvantage of 

selecting options such as Buttons, Dropdowns, Sliders and Status 

Texts is that it may take a second or two before HRD detects that 

you are changing the frequency by dragging the tuning marker and 

the current refresh operation cannot be interrupted.  

Slow Link 

If you have a slow link - a round-trip time > 100 ms - then select only Meters. As 

this is a remote station it is unlikely that anyone else will be adjusting the radio's 

controls so you will not need to refresh buttons and dropdowns as you would 

with a locally connected radio. 

The disadvantage of not selecting Buttons and Dropdowns is that inter-button 

dependencies will not be shown - for example you may have 4 AGC buttons Off, 

Fast, Medium and Slow, only one of which will be active at any one time. If 

Buttons is not enabled for regular refreshes then pressing Fast will not update the 

other AGC buttons. In this case you must press the small refresh button to the 

right of the Buttons check box. 

To refresh all display options click Refresh All. 

Problem Solving 

The following steps are recommended to solve problems using the remote 

server. 

1. Run HRD on the remote computer to check that you can actually 

connect to your radio. 

2. When you connect to the remote server make sure you have closed 

HRD on the remote computer. If you get the error “Access is 

Denied” then the COM port is held open by another program. 

HRD Serial Port Client 

Starting 

Select Port Client from the from the Tools> Programs menu. 
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You must define the serial port mappings before you connect to the serial port 

server running on the remote computer. 

Mappings 

Press  Add to define a new mapping. 

 

Each mapping consists of: 

 Title – whatever makes sense to you. In this case we‟re mapping to 

a K1EL WinKey on Simon‟s remote station in the south pacific. 

 The local port – one of the virtual null modem ports. Here the two 

ports are COM20 and COM21. 

 The remote port – Simon has connected the WinKey to COM1 on 

the remote computer. 

 Remote port settings – WinKey uses 1200,8,none,1 . 

 [X]Enable DTR and [_] Enable RTS – usually checked to provide 

power to a special powered cable or device. For Winkey you must 

check DTR to provide power to WinKey! 

Remote Port Settings 

Some useful remote port settings are: 

 WinKey – 1200,8,none,1 and [X] Enable DTR. 

 AlfaSpid RAS rotator – 600,8,none,1. 

 AlfaSpid RAS rotator – 1200,8,none,1. 

 Idiom Press rotator – 4800,8,none,1. 



Connecting 

Press  Connect to connect to the serial port server on the remote computer. 

 

In the Connect to field enter the remote address, for example 201.42.12.246. If 

you are not using the default port (7806) then append a colon and the port 

number, for example 201.42.12.246:7808 to connect to port 7808 on 

201.42.12.246. 

In the Username and Password fields enter the username and password you have 

been given; these must also be entered in the configuration file. 

When you have finished just press Connect. 

Assuming everything works correctly the client will display log information 

similar to that below: 

 

The client makes two connections; one to send data, the other to receive data. 

The remote server returns a list of known serial ports after the first connection is 

established, in this case COM1, COM3, COM4, COM5 and COM6. 

Now check the Simon’s WinKey mapping and you see logfile messages as the 

local (COM20) and remote (COM1) serial ports are opened. 
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Now you can connect to the remote WinKey using COM21 (the other half of the 

COM20  COM21 virtual cable). 

If you enable  Tracing you see the data sent and received as the WinKey code 

runs through the initialization and performs an echoback test. 

 

Congratulations – you can now use your remote WinKey. 

HRD Serial Port Server 

Installing 

The HRD Serial Port files are: 

 HRDSerialPortSvr.exe – the executable, and 

 HRDSerialPortSvr.cfg – configuration file. 

To install the service select Remote Service from the Tools> Programs menu. 



 

 

Press HRD Serial Port Server to select this server. 

Press Install to install the service, and then press Start to start the service. 

You can start the Windows Services applet (Start – Settings – Control Panel – 

Administrative Tools – Services) to modify the properties of the service, for 

example disabling automatic startup. 

 

Firewall 

Allow incoming connections on port 7806. 



 Remote Station Support    123 

Configuring 

Press Configure to edit HRDSerialPortSvr.cfg that contains the service 

configuration. 





 Rotator    125 

Rotator 

Introduction 

 

What better way to spend money than on a nice set of antennas for your Satellite 

Tracking array, or how about a nice 4-element yagi for 80m? 

Whichever solution you chose HRD has the support you need. 

Main Window 

To open the rotator window select Rotator from the Tools menu. 

 

HRD supports both azimuth-only as well as Azimuth-Elevation rotators such as 

the excellent AlfaSPID. 

To get started press Options (page 9126). 

To change the current bearing either: 

 Enter the new bearing in the Horizontal field and press  < , 

 Enter the locator of the station and press  < , 



 Select a country from the Country dropdown list and press  < , 

 Select a preset, or 

 Double-click on the world map. 

Press Park to park the rotator. 

To select a new bitmap for the World map press Map. Currently only BMP files 

are supported; in a future release other formats and a better resolution will be 

added. 

To switch between short path and long path use the two radio buttons Short and 

Long. 

Options 
Here you configure the rotator you are using. 

Connect 

 

To connect to a rotator: 

 Select the COM port, 

 The rotator type, 

 The connection speed, 

 Press Connect. 

Look in the Logfile (page 127) if you have problems connecting. 

Enter the park position for the rotator – nice shortcut especially if using a 

satellite array. 

Enter your locator so that HRD can compute bearings from your station. 

The most recently returned status is displayed in the Current Status area. The 

current status is read when you connect to the rotator controller. 

Limits 

 

For rotators with elevation support – enter the minimum elevation. If you look at 

the picture on page 125 you see that there is no point in using an elevation lower 

than 5 degrees. 
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Presets 

 

Enter preset bearings for your friends, DX-expeditions or just anywhere of 

interest. As you change this list the main window‟s preset list is updated. 

Double-click on entries to apply immediately. 

Logfile 

  
The logfile is an invaluable aid for you and software developers when 

diagnosing a problem. You see all traffic over the COM port. 

In this example a connection is made with an AlfaSPID rotator.
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Satellite Tracking 

Introduction 

If you are new to satellite tracking visit http://www.amsat.org/ maintained by 

The Radio Amateur Satellite Corporation (AMSAT) for excellent articles written 

for new satellite users. 

HRD‟s Satellite Tracking support would not be possible without the help of 

David Taylor and his open source satellite-tracking library. 

After using David‟s code to get started I wrote my won library, shipped as a 

DLL with HRD and based on NORAD SGP4/SDP4 Implementations by 

Michael F. Henry. Full source is available on request. 

The most important rule: it's the frequency on the satellite that is important, not 

the frequency on your radio. This is the most common mistake made when using 

a satellite. 

If you are using two radios for satellite tracking – one for transmit, the other for 

receive – read this section first, then refer to Synchroniser on page 145. 

Dual radio support is arguably the most flexible way to work with satellites. 

Satellites 

The software requires information about the satellites you will be tracking, this 

information is known as Keplerian elements. Johannes Kepler (1571 – 1630) 

discovered the three laws of planetary motion in 1609 and 1619 – a remarkable 

feat! 

http://www.amsat.org/
http://www.satsignal.net/


 

The satellites window lists the files containing the Keplerian elements used to 

plot the position of satellites and compute the correct frequencies for the uplink 

and downlink. 

The default folder is Satellites located below the folder where you have installed 

HRD - for example: 

C:\Program Files\Amateur Radio\Ham Radio Deluxe\Satellites. 

To change the folder just press Select. 

It is recommended that you update the data files in the Satellites folder when you 

start using Ham Radio Deluxe as the files shipped in the kits will be out of date 

by the time you start to use them. These files should ideally be refreshed every 

few days. 

If you check the ‘Download when Satellite Tracking starts’ option then the files 

are downloaded every time you start satellite tracking. 

To download the latest Kepler data files press Download. The files are 

downloaded to the folder containing your satellite data. 

To edit the list of files press Edit List. The file is HRD Satellite List.txt in the 

folder Satellites folder. 

Example: 
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New satellite data files can be downloaded from the Internet, for example from 

http://www.amsat.org/ or from http://www.celestrak.com/ maintained by T.S. 

Kelso. 

The only supported file format is two-line element sets, for example: 

 

The verbose format is not supported.  

The bare NASA format elements from http://www.amsat.org/ contain all 

satellites of interest to radio amateurs. 

Alternatively if you look at http://www.celestrak.com/NORAD/elements/ you 

will see many files that can be downloaded. Just download these files and save 

them in the Satellites folder selected previously. For more information about the 

contents of these files browse http://www.celestrak.com/. 

All text files in the Data Folder are loaded into Ham Radio Deluxe, so you 

should delete old files if you no longer need them. 

Select up to 100 entries from the Available list by either double-clicking on 

individual entries or by highlighting one or more entries and pressing  >  . By 

pressing  >>  all entries (up to a maximum of 100) are moved to the Selected list. 

http://www.amsat.org/
http://www.celestrak.com/
http://www.amsat.org/
http://www.celestrak.com/NORAD/elements/
http://www.celestrak.com/


Observer 

 

In the Observer window you enter your location and height above sea level in 

meters or feet (for users more familiar with imperial measurements: 1 metre is 

3.3 feet). You also enter an optional list of stations that are plotted on the world 

maps. Only the checked [X] entries are plotted. 

Enter your location either: 

 By entering your Maidenhead Locator in the Locator field and the 

pressing Convert >>  or 

 By entering the Latitude and Longitude directly. 

You also select the preferred time format; either Local (default) or UTC. 

Distance is displayed in either kilometers or miles. 

You must press Apply to update the satellite settings. 
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Ground Control 

 

This window is used to adjust your radio's TX (uplink) and RX (downlink) 

frequency to compensate for the Doppler effect (the apparent shift in frequency 

of a wave due to the relative motion of source and observer). Doppler shift is 

calculated in accordance with Kepler's laws. 

 Enter the satellite uplink (your TX) frequency in the Satellite TX 

field. 

 Enter the satellite downlink (your RX) frequency in the Satellite 

RX field. 

 Select the VFO you will use for TX and RX (see rest of this 

section). 

 If you are using a transverter select the Options tab and enter the 

transverter offsets. 

When you are tuning remember that the important frequency is the satellite 

frequency, not the frequency on your radio. The frequency on your radio is the 

satellite frequency corrected for Doppler shift. 

Tabs 

Plot 

A plot of the selected satellite‟s position and footprint. Use the plot offset 

buttons  to offset the plot time. 



 

Options 

Infrequently used options are located here to avoid cluttering up the display. 

 

  Swaps TX and RX frequencies. 

  Copies TX frequency to the RX. 

  Copies RX frequency to the TX. 

  Displays pass details using the default text editor, 

useful for programming memories in a handheld UHF/VHF 

transceiver. 

 

For example: 

  

  Reloads the latest Kepler data – see Satellites on 

page 129. 

 Doppler – the current frequency correction. 

 Transverter – if you are using a transverter enter the correct offsets 

here and check TX and RX as appropriate. 

AMSAT.org 

The satellite‟s page in AMSAT.org (if available). Note: not all satellites are 

supported yet. 

This is a useful way of getting information about satellites modes and 

frequencies.  



 Satellite Tracking    135 

 

 

Kenwood TS-2000 

The computer can only update both main and sub frequencies either: 

 In receive mode, or 

 In transmit mode with SAT selected. 

A special solution is required when the uplink (TX) and downlink (RX) 

frequencies are in the same band. When you start the TS-2000 you have an extra 

TX VFO option Sub+XIT which is only used for same band split operation (see 

below). When selected the Sub VFO is used for transmitting, Doppler correction 

is applied by adjusting the XIT value. 

Cross Band 

In normal cross-band satellite mode (for example transmit on 70cms and receive 

on 2m) select: 

 TX VFO B/Sub (the TS-2000 always uses the Sub VFO for 

TX), 

 RX VFO A/Main, 

 SAT on, 

 Split off. 

The TS-2000 must be in satellite mode so that the computer can update the TX 

frequency. 

Be careful with the TS-2000's TF SET button, each time you press TF-SET the 

uplink (TX) frequency and the downlink (RX) frequency are swapped. So if the 

frequencies in HRD are the opposite of those shown on the radio just press TF 

SET once. 

Same Band (Split) 

An example is talking to the astronauts on the ISS where the TX frequency is 

145.200.000 MHz and the RX frequency is 145.800.00 MHz. You cannot use 

SAT mode as this is only used for cross-band operation, so you use Split mode. 

 TX VFO Sub+XIT, 

 RX VFO Main, 

 SAT off, 

 Split on. 



XIT will be switched on as soon as you check TX [X] updates. If you switch it 

off then HRD will switch it on again. 

The RX (main) frequency on the TS-2000 is set to the correct RX frequency 

(satellite + Doppler correction). 

The TX (sub) frequency on the TS-2000 is set to the TX satellite frequency; the 

Doppler correction is applied by adjusting the XIT value. When you transmit the 

TS-2000 displays the TX (sub) frequency +/- XIT so the frequency displayed on 

the TS-2000 is the correct frequency (satellite + Doppler correction). 

When you start transmitting you may hear beeps from the radio - it takes HRD a 

few seconds before it detects that you are transmitting. When HRD detects 

transmit mode it stops updating the RX (main) frequency until you return to 

receive as the frequency cannot be updated by the computer while transmitting 

with SAT off. 

Yaesu 

FT-847 

You must select SAT mode on the FT-847 so that Ham Radio Deluxe can read 

and set both the TX and RX frequencies. It is not possible to determine the state 

of the FT-847's SAT button so you must press the SAT button in HRD so that it 

shows SAT as being enabled. 

In normal cross-band satellite mode (for example transmit on 70cms and receive 

on 2m) select: 

 TX VFO B/Sub, 

 RX VFO A/Main, 

 SAT on, 

 Split off, 

 Tracking off (you do not need to enable tracking, the computer 

does everything for you, also the tuning response with HRD is 

much faster with tracking off). To switch tracking off press the A > 

B button underneath Track. 

The FT-847 must be in satellite mode so that the computer can update the TX 

frequency. 

When in SAT mode the FT-847 takes a long time to respond to 'Read Frequency' 

requests - especially if tracking is on, as a result when you tune the FT-847 with 

the radio's tuning dial the displayed frequency will not update very quickly. 

Other 

The transmit frequency of some Yaesu radios such as the FT-817 and FT-857 

cannot be changed while in transmit mode, so it is not possible to apply Doppler 

correction while transmitting. If you think your Yaesu radio can be updated 

while transmitting please contact the author. 

ICOM 

IC-910H 

In normal cross-band satellite mode (for example transmit on 70cms and receive 

on 2m) select: 

 TX VFO Sub, 
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 RX VFO Main, 

 SAT on. 

The IC-910H must be in satellite mode so that the TX uses the Sub frequency. If 

the bands on the radio are the same as HRD but reversed press M / S to switch 

the Main and Sub frequencies. 

Because the IC-910H cannot display the same band on both Main and Sub HRD 

cannot update the frequencies unless the correct bands are select using the radio 

controls. 

In same-band mode: 

 TX VFO Main, 

 RX VFO Main, 

 SAT off. 

A few notes: 

1. The TX mode is not updated from the radio. 

2. The software has to switch between Main and Sub so that the Sub 

VFO is updated, it is not possible to detect the radio's current Main 

/ Sub selection so the radio operates in main mode all the time. If 

you press Sub on the radio you will see that radio switch back to 

Main as soon as the Sub frequency is updated. 

Single VFO Radios 

If you are using a single VFO radio such as the FT-817 then you use the same 

VFO for TX and RX. Use the TX (F1) button to switch between TX and RX. 

When you switch to TX the transmit frequency is loaded into the radio before it 

switches to transmit, when you return to receive the receive frequency is loaded 

into the radio after it switches to receive. 

So the rule is: always use the TX (F1) button to switch between transmit and 

receive. 

Linear Transponders 

Check [X] the Linear Transponder Tracking option if you are using a linear 

transponder such as HAMSAT / VUSAT / VO-52. These satellites receive a 

specific range of frequencies (typically 40 - 100 kHz) in one band, convert them 

to another band and amplify the converted signal for transmission back to your 

planet. The converted signal is inverted - LSB becomes USB etc. - this is known 

as an inverting transponder. 

Do not use the satellite tracking built into your radio - let HRD do the work for 

you (for example on the FT-847 this is the Tracking option). To set up the linear 

transponder frequencies: 

 TX center The center frequency of the uplink (TX) band. For 

example on VO-52 the uplink band is 435.220-435.280 MHz 

(LSB/CW) so the center frequency is 435.250.000 MHz. 

 RX center The center frequency of the downlink (RX) band. For 

example on VO-52 the downlink band is 145.870-145.930 MHz 

(USB/CW) so the center frequency is 145.900.000 MHz. 

As you tune your RX frequency the TX frequency will be correctly adjusted by 

applying [1] offsets from the center frequencies and then [2] Doppler correction. 

To adjust your transmit signal so that it matches the receive frequency use the 

spin button to the right of the TX center field. It will be necessary to adjust the 



transmit signal as your radio(s) may not be correctly aligned, also the linear 

transponder in the satellite may also not be correctly aligned. 

The tracking option in a radio cannot correctly compensate for Doppler, this is 

one reason why many QSO's drift gently across the linear transponder's available 

bandwidth. Only correct computer control will ensure that two or more stations 

stay on the same frequency while the satellite passes overhead. When using the 

linear transponder option HRD will correctly control your radio's frequencies so 

that are they are both compensated for Doppler shift. 

Frequency Resolution 

The frequency resolution is set the 1 Hz for: 

 All ICOM, 

 All Elecraft, 

 All FlexRadio, 

 All Kenwood . 

All other radios are set to 10 Hz. If you have a radio that supports 1 Hz 

resolution and is not in the above list please contact the author. 

Options 
Option Description 

VFO The VFO used for the uplink (TX) and downlink (RX). If checked [X] the 

selected VFO is updated regularly as the satellite frequency is corrected 
for Doppler shift. 

Satellite The satellite frequency. Click the Open button to select a new frequency 

from a popup window containing the Favourites definitions or enter the 
new frequency. 

Transverter If you are using a transverter enter your transverter's intermediate 

frequency here and check the [X] box. If you are not using a transverter 

either leave this field empty or do not check the [X] box. The radio 

frequency is calculated as: Satellite - Transverter + Doppler shift. 

Radio The radio frequency as computed by HRD taking Doppler shift into 

account. 

Satellite Select the current satellite from a dropdown list that contains the entries 

selected earlier in the Satellites window. 

Plot for Determines the amount of information that is plotted over the surface of 

the planet for the current satellite. 

TX > RX Copy the Uplink satellite frequency to the Downlink satellite frequency. 

RX > TX Copy the Downlink satellite frequency to the Uplink satellite frequency. 

TX <> RX Exchange the Uplink and Downlink satellite frequencies. 
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Schedule 

 

This window shows the pass schedule for the satellites selected in the Satellites 

window. 

Current Data 

 

This window shows all computed information for a selected satellite. This 

window provides the data for the Ground Control and DDE windows. 

Press Viewer to display the data with the default text file viewer, usually 

Notepad. 



Mutual Visibility 

 

The mutual visibility window answers the question 'when is a satellite 

simultaneously visible from two or more locations'. 

The information is determined up to 99 days in the future for any stations from 

the list defined in the Observer page. 

The satellite is considered to be visible if the elevation is the same as or greater 

than the selected value. 

Use the Viewer option to display the data in Notepad, for example: 
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Visibility 

 

The visibility window gives you an overview of the satellites you have selected 

in the Satellites window. 

Select the satellites that are displayed: 

 All - displays all satellites, 

 Visible now - displays only the satellites which are currently 

visible, 

 Visible in next… - displays the satellites visible at any time in the 

time period you select, for example the next 60 minutes. 

For each entry in this display the columns are:  

Column Description 

Vis Whether the satellite is currently visible. 

Satellite The name of the satellite. 

Azimuth The azimuth of a satellite is the angle between the vertical plane containing 

it and the plane of the meridian. It is customary to reckon the azimuth of a 

line from the south point of the horizon around by the west from 0[deg] to 

360[deg]. 

Elevation The angular distance above the horizon. 

AOS Acquisition of signal is the elapsed time at which the satellite becomes 

visible and a signal can theoretically be heard. If empty then the satellite is 
already visible. 

LOS Loss of signal is the elapsed time after which the satellite is no longer 

visible and the signal can theoretically no longer be heard. 

Lon The satellite's current longitude. 

Lat The satellite's current latitude. 

Range The distance of the satellite from the observer's location measured in 

kilometers. (A mile is 1.6 kilometers; a kilometer is 0.62 miles.) 

Altitude The altitude of the satellite above sea level measured in meters. 

Range 
Rate 

The value required to calculate Doppler frequency adjustment. 

 



Next Passes 

 

This window shows up to 1,000 passes for a selected satellite. Note: do not 

select more than 100 passes unless you have a very powerful computer, 

minimum CPU frequency of 2 GHz is recommended. 

Press Alarm to add an audio alarm when a satellite is about to pass overhead. 

Press Plot to plot a selected pass in the Single Pass window. 

Press Viewer to display the data with the default text file viewer, usually 

Notepad. 

Single Pass 
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This window plots a single pass for the satellite selected in the Next Passes 

window. The elevation is plotted on the left y-axis; time is on the x-axis. Select 

Azimuth, Altitude or Range to be plotted on the right y-axis. 

If Popup info is checked a vertical dashed marker line is displayed which either 

tracks the current time or is positioned by clicking on the chart with the left 

mouse button. 

As the marker position changes, the azimuth, elevation, altitude and range are 

displayed in the marker fields. 

Plot 

 

This window shows the position of one to four satellites above the surface of the 

planet. 



DDE 

 

This window controls the DDE server. If you want to use HRD's data with 

another program you must start HRD's DDE Server. Select the DDE format: 

currently only Nova is supported. Press Start to start the DDE server. 
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Synchroniser 

Introduction 

The synchronizer is used to control two or more radios where a common 

frequency is shared by using the Dynamic Data Exchange (DDE) mechanism. 

For each radio you are using you start an instance of HRD, one instance is the 

Master, the rest are the Slaves, the slaves receive frequency and mode 

information from the master. 

Starting 

Start the Synchroniser from the Tools> Programs menu, then press Scan to find 

the active HRD instances. 

 

Select the master instance (supplied the frequency and mode), and then press 

Start. 



 

In the Frequency and Mode dropdowns you select the corresponding source from 

the HRD master instance: 

 Radio – as seen on the main HRD display, 

 Transverter – frequency is taken from the Transverter window 

(selected from the Tools menu). 

 Satellite uplink – the uplink frequency and mode (see Ground 

Control on page 133). 

 Satellite downlink – the downlink frequency and mode (see Ground 

Control on page 133). 

In the HRD Slaves group box check the instances to be controlled by the 

Synchroniser. 

As soon as you check a slave the slave‟s frequency and mode are updated with 

the current values from the master; every time the master frequency and / or 

mode change they are sent to the slave for so long as the slave option remains 

checked. 

Dual Radio Satellite Tracking 
Refer to Satellite Tracking on page 129, specifically Ground Control on page 

133. 

If you are using two radios for satellite tracking (for example two FT-817 or IC-

7000): 

1. Start an instance of HRD for each radio; connect to the radios. 

2. Select an instance to use as the master, in this example the radio 

used for receive. 

3. In the master (receive) instance: 
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 Start the display.  

 Enter transmit and receive frequency information for the 

satellite you are tracking. 

 Check the RX VFO, do not check a TX VFO as this 

instance will not be used for transmit. 

4. Start the Synchroniser: 

 Master is the receive instance, 

 Slave is the transmit instance, 

 Select the Satellite uplink option for Frequency and Mode so 

that the slave receives the frequency and mode used for 

transmit as computer by the Master instance. 

The slave will now be updated with the transmit frequency and mode for 

transmit every time it changes in the master instance. 
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3
rd

-Party Programs 

Introduction 

HRD supports 3rd-party programs such as logbooks via a virtual serial port. See 

also DDE Support on page 61. 

An example of a virtual serial port is available from Phil Covington N8VB. His 

homepage is http://www.philcovington.com/SDR.html look for the N8VB vCOM 

Virtual Serial Ports Driver download. 

To install the vCOM drivers see Annex: N8VB vCOM on page 163. 

The N8VB driver works with Windows 2000, XP and higher. Windows 

95/98/SE/ME and NT 4.0 are not supported. 

N8VB's solution creates a pair of virtual COM ports (virtual because there is no 

hardware associated with a virtual COM port). The ports are effectively 

connected back-to-back – just like a normal serial cable. 

In the description that follows two ports are created during the installation, 

COM7 (used by HRD) and COM8 (used by the 3rd-party program). 

 HRD opens and listens on COM7 port for incoming requests. 

 The other program opens COM8 in exactly the same way it would 

connect to a radio using a hardware serial port. 

The connection parameters used by the 3
rd

-party program to connect with COM8 

are: 

 Speed any (9600 by default but this really doesn't matter), 

 Stop bits 2, 

 Parity none. 

The protocol supported is Kenwood, the command set current supported is: 

 FA Get / set VFO-A. 

 FB Get / set VFO-B. 

 MD Get / set mode. 

 IF Read status, currently frequency, TX status, and mode are 

supported, 

 SM Read the S-Meter. 

To use this option Ham Radio Deluxe must be connected to a radio, otherwise 

the standard Kenwood error response ?; will be returned. The radio does not 

have to support the Kenwood protocol as Ham Radio Deluxe makes the 

necessary conversions. 

http://www.philcovington.com/SDR.html


Configuring 

Select 3
rd

-Party Serial Port from the Tools menu. 

 

Enable opens the connection on the selected port – in this case COM7. 

Check Connect to automatically open the connected everything HRD starts. 

In the Port dropdown you select the COM port to use 

The Mode dropdown is reserved for future use. The only option is Default. 

And that‟s all there is to it. 

 

Testing 

To test the connection: 

 Start HyperTerminal (supplied with Windows). 

 Connect to COM8 (the virtual serial port used by the 3
rd

 party 

programs). 

  Enter FA; you will see a value such as FA00050100000; returned 

(50.1 MHz). 

 

Command Detail 

FA Reads and sets the VFO A frequency in Hz 

Set FA<11 digit frequency>; 

Read FA; 

Answer FA<11 digit frequency>; 

FB Reads and sets the VFO B frequency in Hz 
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Set FB<11 digit frequency>; 

Read FB; 

Answer FB<11 digit frequency>; 

IF Retrieves the transceiver status 

Read IF; 

Answer IFP1P2P3P4p5P6P7P8P9P10P11P12P13P14P15; 

 

Where: 

    P1  = 11 digits, frequency in Hz 

    P2  =  5 digits, not used 

    P3  =  5 digits, not used 

    P4  =  1 digit,  not used 

    P5  =  1 digit,  not used 

    P6  =  1 digit,  not used 

    P7  =  2 digits, not used 

    P8  =  1 digit,  0: RX, 1: TX 

    P9  =  1 digit,  see MD above 

    P10 =  1 digit,  not used 

    P11 =  1 digit,  not used 

    P12 =  1 digit,  not used 

    P13 =  1 digit,  not used 

    P14 =  2 digits, not used 

    P15 =  1 digit,  not used 

MD Recalls or reads the operating mode status 

Set MD<mode>; 

Read MD; 

Answer MD<mode>; 

 

Where mode is one of: 

    0: None 

    1: LSB 

    2: USB 

    3: CW 

    4: FM 

    5: AM 

    6: FSK 

    7: CWR (CW Reverse) 

    8: Tune 

    9: FSR (FSK Reverse) 

SM Retrieves the S-Meter value 

Read SM; 

Answer IF<4 digit value>; 

 

Where the returned value range is from 0000 to 

0030. Each unit is 1/2 an S-unit. S5 is 0010, S9 is 

0018.
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Annex: Command Tester 

Introduction 

Too Many Radios 

In a project like Ham Radio Deluxe it is not always possible for the developers 

to have every radio available for their own use: it‟s very expensive and takes up 

too much room. 

This is where the user community helps - by using the Command Tester 

individual commands are tested by the users of Ham Radio Deluxe and the 

results sent to the developers as a text file in a standard format. 

Very often the problem is either determining the data returned for the various 

mode / filter / frequency combinations supported by a rig or working out how to 

set a rig option. 

The handbooks supplied by manufacturers can be wrong or just not contain 

enough information to successfully implement a command. 

Data Formats 

There are major differences in the formats selected by the manufacturers whose 

radios are supported by Ham Radio Deluxe. 

The Command Tester supports all necessary formats for the radio manufacturers 

supported by Ham Radio Deluxe. 

Command Types 

There are two types of command – Get and Set. 

A Get command returns an item of information, for example the VFO frequency 

or mode. A Set command changes a rig setting, typically the frequency or mode. 

Command Tester supports both Get and Set commands. 

Starting 

To start the Command Tester: 

 Make sure you have not connected to a radio with Ham Radio Deluxe if 

you will be using the same COM port for the Command Tester. If you 

have a radio connection then you must disconnect using the Disconnect 

option in the File menu. 



 Select Command Tester from the Tools menu. 

 

Connect 

To connect to your radio you must select: 

 COM port where you have connected the interface cable to the 

radio, 

 The baud rate (COM port speed). If you are not sure of the correct 

speed consult your radio manual. 

 CTS used for flow control, specifies whether the CTS (clear-to-

send) signal is monitored for output flow control. Used by 

Kenwood.  

 DTR used either for flow control or to provide power for the CAT 

interface. This depends on the manufacturer‟s protocol and your 

CAT interface. 

 RTS used either for flow control or to provide power for the CAT 

interface.  This depends on the manufacturer‟s protocol and your 

CAT interface. 

Then press Connect. 

When you press Connect a warning message is displayed. Using incorrect 

commands can confuse some radios, so if you are not sure what you are doing 

now is the time to leave Command Tester. 

 

Press Yes to continue. 

General Options 

These options are common to all formats. 
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 Send - sends a command to the radio. 

 Erase - clears the contents of the results window. 

 Save - saves the contents of the results to a file in ASCII format. 

You can send the contents of this file by email to help the 

developers of ham Radio Deluxe. 

 Help - pressing help displays the contents of the small help window 

as a text file using Notepad. 

 Close - closes the Command Tester. If there are entries in the 

results window you are prompted to save them first. 

Results 

The results are shown in the bottom half of the Command Tester window. 

 Title – as entered in the Title: field. 

 Send – the command sent to the rig, shown in ASCII and/or Hex as 

appropriate. 

 Received – the received data, shown in ASCII and/or Hex as 

appropriate. 

Platforms 

Examples of HRD use with various platforms is shown here. 

Elecraft 

The Elecraft protocol uses ASCII characters; it appears to be based more-or-less 

on the Kenwood protocol. Refer to the „Elecraft KIO2 Programmer‟s Reference‟ 

for full information. 

The data sent and received is always shown in ASCII (text) that makes 

debugging relatively easy. 

If you select Show hex output the returned data is also shown in hexadecimal 

(see the Change mode to RTTY below). 

When a Set command is sent – for example MD6; to set the mode to RTTY there 

is no response from the rig, so instead MD6;MD; is sent – set the mode to RTTY 

(MD6;) and then read the mode (MD;) – this way there is always returned data. 

  



In the Change mode to RTTY example above the returned string is shown in both 

ASCII and hexadecimal because the Show hex output option was selected for 

this command. 

Fields 

 Title - a description of the command you are testing, for example 

„Read Frequency‟ or „read Mode‟. Mandatory 

 Cmd - the ASCII string sent to the rig. Elecraft strings are 

terminated with a ; 

 Wait for rx terminator - when reading the response read characters 

from the rig until this character is returned or a timeout occurs. 

Examples 

Test Description 

Read Frequency Command is FA; returned data format is FA + 11 digits + ;. 

 FA00007035000; 

Frequency is 7.035.000 MHz. 

Read Mode Command is MD; returned data format is MD + 1 digit + ;. 

 MD1; 

(1=LSB, 2=USB, 3=CW, 6=RTTY, 7=CW-REV, 9=RTTY-REV) 

Read S-Meter Command is SM; returned data format is SM + 4 digits + ;. 

 SM0000; 

Returned value is in the range 0000 to 0015. 

ICOM CI-V 

The example below is uses an IC-7800 with: 

 From: (controller address) E0 (personal computer, the default 

value), 

 To: (CI-V address) 6A (the default for the IC-703). Refer to your 

ICOM radio manual for the correct CI-V address for your rig. 

The data received from the radio is always shown in hexadecimal. 

 

Fields 

 Title - a description of the command you are testing, for example 

„Read Frequency‟ or „read Mode‟. Mandatory 

 From - controller‟s default address. Enter E0 (Personal Computer). 

Mandatory 
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 To - transceiver‟s default address, the IC-703 uses 68. The address 

used by your radio is found in the user manual. Mandatory 

 Cmd - command number (refer to the radio handbook). Mandatory 

 Sub - sub command number (refer to the radio handbook). If there 

is no sub command then this field must be left empty. Optional 

 Data - if the command supplies data (for example setting a new 

frequency or mode) then enter the values in these fields. If there is 

no data for the command then these fields must be left empty. 

Examples 

These examples show a CI-V address of 6A, the default for the IC-7800. Change 

this to the CI-V address assigned to your radio. 

Test Description 

Read 

frequency 

Command is 03, no sub command or data; these fields must be left 

empty. 

The returned data is: 

 FE FE (preamble) 

 E0 (Controller address) 

 6A (IC-7800 CI-V address) 

 03 (Command number) 

 89 38 06 07 00 (frequency in BCD format) 

 FD (end of message) 

Read Mode Command is 04, no sub command or data; these fields must be left 

empty. 

The returned data is: 

 FE FE (preamble) 

 E0 (Controller address) 

 6A (IC-7800 CI-V address) 

 04 (Command number) 

 00 01 (mode) 

 FD (end of message) 

Read S-Meter Command is 15, sub command is 02. There is no data; these fields must 

be left empty. 

The returned data is: 

 FE FE (preamble) 

 E0 (Controller address) 

 6A (IC-7800 CI-V address) 

 15 (Command number) 

 02 (Sub command number) 

 01 09 (s-meter value) 

 FD (end of message) 

Mode / Filter 

A common problem is determining the data returned for the possible mode and 

filter combinations. 



To list all combinations follow the following steps for each mode and filter 

combination: 

 Select the Mode and Filter on your rig using the rig buttons and 

controls. 

 Enter a value in the Command Tester Title field which corresponds 

to the mode and filter selected in 1 above, for example Mode = 

USB, Filter = Wide. 

 Enter a command of 04; clear the sub command and data fields. 

 Press Send . 

When you have finished press Save to save the contents of the Results window 

to a file which you can forward to the Ham Radio Deluxe development team. 

Other 

Follow the logic in Mode / Filter above for other commands which you want to 

investigate: 

 Select the option on your rig using the rig buttons and controls. 

 Enter a value in the Command Tester Title field that corresponds to 

the option you are investigating. 

 Referring to your rig‟s handbook enter the command, sub 

command and data value as appropriate to read the rig‟s current 

value or set a new value. If there is no sub command or data then 

these fields must be left empty. 

 Press Send. 

Yaesu 

Starting with the FTDX-9000 Yaesu has changed the CAT protocol to one very 

similar to that used by Kenwood. So if you are fortunate enough to have the 

FTDX-9000 please use the Kenwood commands. 

The example below uses the FT-817. The data received from the radio is always 

shown in hexadecimal. The overall format of Yaesu commands is always P1 – 

P4 + OpCode, the actual commands and the data returned from the rig depends 

on the model and also on the EPROM revision level. 

Some commands do not require specific values for P1 – P4, it is recommended 

that is a value is not specified in the radio handbook then you enter 00, this is the 

approach taken in Ham Radio Deluxe. 

Be aware that there are many errors in the Yaesu documentation, so the data 

returned may not agree with the handbook and the radio‟s current settings. 
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Fields 

 Title - a description of the command you are testing, for example 

„Read Frequency‟ or „read Mode‟. Mandatory 

 P1 – P4 - the command parameters. Not all commands require 

parameters; it is recommended that parameters that can be set to 

any value be set to 00. Fields left empty are set to 00. 

 OpCode - the instruction OpCode. Mandatory. 

Examples 

Test Description 

Read 

frequency 
and mode 

The OpCode is 03, P1-P4 can have any value, in this example they are 

set to 00. 

 P1: 00 P2: 00 P3: 00 P4: 00 OpCode: 03 

The format of the returned data is 5 bytes, the first four containing the 

frequency in binary coded decimal followed by the mode. 

The returned value is 00 35 78 15 00 which corresponds to a frequency 
(00 35 78 15) of 51.875.300 and a mode (00) of LSB. 

Read RX 

status 

The opcode is E7, P1-P4 can have any value, in this example they are set 

to 00. 

 P1: 00 P2: 00 P3: 00 P4: 00 OpCode: E7 

The format of the returned data is 1 byte. 

The returned value is 00. 

Read TX 

status 

The OpCode is F7, P1-P4 can have any value, in this example they are 

set to 00. 

 P1: 00 P2: 00 P3: 00 P4: 00 OpCode: F7 

The format of the returned data is 1 byte. 

The returned value is FF (not in TX mode). 

Other Commands 

For the commands you want to investigate: 

 Select the option on your rig using the rig buttons and controls. 

 Enter a value in the Command Tester Title field that corresponds to 

the option you are investigating. 

 Referring to your rig‟s handbook enter the P1 – P4 parameters and 

OpCode as appropriate to read the rig‟s current value or set a new 



value. If there are no values specified for P1 – P4 then enter 00 in 

these fields. 

 Press Send. 
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Annex: Portmon 

Introduction 

This excellent utility for monitoring COM port activity can be downloaded from 

http://www.sysinternals.com/ . 

Quoting the Sysinternals website: “Portmon is a utility that monitors and 

displays all serial and parallel port activity on a system. It has advanced filtering 

and search capabilities that make it a powerful tool for exploring the way 

Windows works, seeing how applications use ports, or tracking down problems 

in system or application configurations.  

Portmon works on NT 4.0, Win2K, XP and Server 2003, Windows 95 and 

Windows 98.” 

It is often useful to run Portmon when unexpected results are returned from a 

radio (or other device such as a rotator or keyer). 

The Steps: 

 Close any programs connected to your radio or device being 

interrogated. 

 Start Portmon.exe 

 Make sure these options are set: 

 

Menu Option State / Comment 

Options Show Time ON 

Options Show HEX ON if ICOM, Yaesu or TenTec 

OFF if Elecraft, Kenwood  
ON if you are not sure (I read hex) 

Options Clock Time OFF 

Computer Select your local computer 

Capture Ports The COM port where you have connected the 

interface to your radio, select only one COM port 

to avoid confusion. 

Capture Capture Events ON 

 Start HRD then connect to your radio.  

 Let HRD run for about 60 seconds while you perform your tests. 

 Stop HRD (File menu: Disconnect). 

http://www.sysinternals.com/


 In Portmon set the Capture: Capture Events option to OFF. 

 Save the logfile to disk, put into a zip file if possible and send to 

mailto:simon@hb9drv.ch . 

Sample Log 

For this example the Process and Port columns are not shown to save space. The 

log shows the startup for an IC-78000, results are in Hex. The Time for each 

command is shown which helps detect timeouts. 

mailto:simon@hb9drv.ch
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Annex: N8VB vCOM 

Introduction 

N8VB‟s vCOM driver creates up to ten sets of paired virtual COM ports; use 

these like you would use a null-modem cable. Virtual null-modems are pure 

software; no hardware is involved. 

Note: vCOM is only supported on Windows 2000, and Windows XP. 

When using the 3
rd

-party program support you must use a virtual null-modem 

cable to connect HRD to the 3
rd

-party program. HRD opens one end of the 

virtual cable; the 3
rd

-party program opens the other. 

Virtual null-modems are also used in the remote station support to connect HRD 

to the HRD serial port client program – see Remote Station Support on page 111. 

N8VB‟s vCOM driver is copyrighted 2005 by Philip A Covington N8VB. 

Configuration 

The easiest way to install the N8VB vCOM driver is by selecting N8VB vCOM 

Configuration from the Tools menu. 

With this window you can install, update or remove the vCOM driver. 



 

In the above example the driver version is 0.0.0.226 or build 266. 

Input Files 

The key files are: 

 Driver – vCOM.sys, 

 Information – N8VBvCOM.inf, 

 Device console utility - devcon.exe (a command-line utility that 

acts as an alternative to Device Manager). 

These files are shipped in the vCOM sub-folder.  

 To install a different version of the vCOM driver you must find the kit on 

N8VB‟s website, unpack it and select the information and device driver files. 

 Selects the default files shipped with HRD. 

Ports 

Select the number of paired ports (null-modem cables) to be created and the port 

numbers assigned to the pairs. The port numbers must be unique; you must not 

select a port number already assigned to a hardware device such as the COM 

port on your computer. 

If the vCOM driver is already installed the current values are read from the 

registry, the key is: 

HKEY_LOCAL_MACHINE 

    SYSTEM 

        CurrentControlSet 

            Enum 

                Root 

                    MULTIPORTSERIAL 

                        0000 

                            Device Parameters 
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 Loads the default values from the currently select 

information (.INF) file. 

Installation 

To install the driver a batch file (install.bat) is created which in turn uses 

devcon.exe. A sample batch file is shown below: 

 

The batch file, device console (devcon.exe), device driver (vCOM.sys) and 

information file (.INF) are copied to a temporary folder. The BAT file is then run 

from this folder. 

When devcon starts you see a window similar to that below if you are using 

Windows XP: 

 

Press  and the installation proceeds. 

A typical log is shown below: 



 

After installing you must reboot your computer. 

Update and Remove follow the same logic as installation using a custom BAT 

file and devcon.exe .
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Annex: Remote Server 

Technical Information 

Remember that the software is designed for Windows NT but it should be 

possible to map all these commands to Linux and other UNIX derivatives. 

The source code for the main processing thread is available; the rest is highly-

Windows oriented and is of no use for other platforms. 

Commands 

The supported commands are: 

Command Description 

MSG_CMD_AUTHENTICATE Authenticate username/password 

MSG_CMD_CLOSE_HANDLE Close COM port. 

MSG_CMD_CREATE_FILE Open a COM port 

MSG_CMD_DEVICE_IO_CONTROL Send control code to COM port driver 

MSG_CMD_GET_COM_PORTS Return a list of COM ports 

MSG_CMD_PURGE_COMM Discards all characters from the input buffer 

of the COM port. Terminates pending read 

or write operations on the resource 

MSG_CMD_READ_FILE Read the COM port 

MSG_CMD_READ_FILE_EX Read the COM port (extended read) 

MSG_CMD_SET_COMM_MASK Specify events to be monitored. 

MSG_CMD_SET_COMM_STATE Configure COM port. 

MSG_CMD_SET_COMM_TIMEOUTS SET timeouts. 

MSG_CMD_WRITE_FILE_ASYNC Asynchronous write, no reply expected 

MSG_CMD_WRITE_FILE_SYNC Synchronous write (reply expected) 

 

All commands expect a reply except for MSG_CMD_WRITE_FILE_ASYNC. 

The command values are: 

enum RemoteSvrMessages 

{ 

 MSG_CMD_AUTHENTICATE      = 0,

 MSG_CMD_GET_COM_PORTS     = 1,

 MSG_CMD_CREATE_FILE       = 2,

 MSG_CMD_DEVICE_IO_CONTROL = 3,

 MSG_CMD_SET_COMM_MASK     = 4,



 MSG_CMD_PURGE_COMM        = 5,

 MSG_CMD_SET_COMM_STATE    = 6,

 MSG_CMD_SET_COMM_TIMEOUTS = 7,

 MSG_CMD_READ_FILE         = 8,

 MSG_CMD_READ_FILE_EX      = 9,

 MSG_CMD_WRITE_FILE_SYNC   = 10,

 MSG_CMD_CLOSE_HANDLE      = 11,

 MSG_CMD_WRITE_FILE_ASYNC  = 12, 

}; 

Structures 

The structures used are shown below. All members are byte-aligned. All 

commands start with the structure 

typedef struct { 

    UINT nSize;     //  Total command size 

    UINT nHead;     //  4 bytes, ‘HRD*’ 

    UINT nCmd;      //  Command index 

} MSG_HEADER; 

 nSize - the total size in bytes of the message being sent. 

 nHead – 4 bytes  of sanity– „HRD*‟. 

 nCmd – a command from the table below. 

 

Command Structure 

MSG_CMD_AUTHENTICATE MSG_AUTHENTICATE 

MSG_CMD_CLOSE_HANDLE MSG_COM_PORT 

MSG_CMD_CREATE_FILE MSG_COM_PORT 

MSG_CMD_DEVICE_IO_CONTROL MSG_COM_PORT 

MSG_CMD_GET_COM_PORTS MSG_GENERAL 

MSG_CMD_PURGE_COMM MSG_COM_PORT 

MSG_CMD_READ_FILE MSG_COM_READ 

MSG_CMD_READ_FILE_EX MSG_COM_READ 

MSG_CMD_SET_COMM_MASK MSG_COM_PORT 

MSG_CMD_SET_COMM_STATE MSG_COM_PORT 

MSG_CMD_SET_COMM_TIMEOUTS MSG_COM_PORT 

MSG_CMD_WRITE_FILE_ASYNC MSG_COM_WRITE 

MSG_CMD_WRITE_FILE_SYNC MSG_COM_WRITE 

 

MSG_AUTHENTICATE  

typedef struct { 

 MSG_HEADER header; 

 BOOL  bAuthenticated; 

 char  szUsername[64]; 

 char  szPassword[64]; 

 char  szStatus[512]; 

} MSG_AUTHENTICATE; 

 

MSG_COM_PORT  

typedef struct { 
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 MSG_HEADER  header; 

 char   lpFileName[32]; 

 DWORD   dwDesiredAccess; 

 DWORD   dwCreationDisposition; 

 

 DWORD   dwIoControlCode; 

 BYTE   byInBuffer[64]; 

 DWORD   dwInBufferSize; 

 BYTE   byOutBuffer[64]; 

 DWORD   dwOutBufferSize; 

 DWORD   dwBytesReturned; 

 

 DWORD   dwFlags; 

 DWORD   dwEvtMask; 

 

 DCB   dcb; 

 COMMTIMEOUTS timeouts; 

 

 HANDLE  hHandle; 

 BOOL   bStatus; 

 char   szStatus[256]; 

} MSG_COM_PORT; 

 

MSG_GENERAL  

typedef struct { 

 MSG_HEADER header; 

 BOOL  bStatus; 

 BYTE  byData[4096]; 

} MSG_GENERAL; 

 

MSG_COM_READ  

typedef struct { 

 MSG_HEADER  header; 

 HANDLE  hHandle; 

 DWORD   dwNumberOfBytesToRead; 

 BYTE   byTermChar; 

 DWORD   dwNumberOfBytesRead; 

 BOOL   bStatus; 

 OVERLAPPED  overlapped; 

 BYTE   byData[4096]; 

} MSG_COM_READ; 

 

MSG_COM_WRITE  

typedef struct { 

 MSG_HEADER  header; 

 HANDLE  hHandle; 

 DWORD   dwNumberOfBytesToWrite; 

 DWORD   dwNumberOfBytesWritten;

 OVERLAPPED  overlapped; 

 BOOL   bStatus; 

 BYTE   byData[4096]; 

} MSG_COM_WRITE; 
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Annex: Settings 

Overview 

User settings are stored in the registry and in files in the user‟s application-

specific data folder. 

Registry 
The registry key used for storing options in HRD is: 

HKEY_CURRENT_USER 

        Software 

                Simon Brown 

                        HamRadioDeluxe 

                                Options 

The values in this key will not make much sense – they are used by HRD to 

preserve settings such as window geometry (size, position) and the current 

scheme. 

The values in the key can be safely deleted at any time. Don‟t change values 

with a registry editor – you may cause unexpected problems for HRD! 

Files 

HRD stores files in the folder defined by CSIDL_APPDATA, this is the file 

system directory that serves as a common repository for application-specific 

data. A typical path is: 

C:\Documents and Settings\username\Application Data\Simon Brown, 

HB9DRV\Ham Radio Deluxe. 

You will not normally need to directly access the files in this folder. 

File Description 

*.css Cascading style sheets, used by HTML export options – for 

example in Logbook Analysis. 

HRD Logbook.mdb Logbook database 

*.opt Optional schemes – see Schemes on page 29. 

HRD Bands 02.txt Band layouts 

HRD Countries.txt A default Log Windows country file 

HRD Custom Defs - 
<radio>.txt 

Custom CAT commands for a specific radio – see CAT 
Commands on page 103. 



HRD Favourites 01.txt See Favourites on page 69. 

HRD Logbook Analysis 
Defns.txt 

TBA 

HRD Macros - TS-

480.txt 

Macro definitions – see Macros on page 103. 

HRD Parallel Port 

Defns.txt 

Parallel port definitions – see Auxiliary Switching on page 

53. 

HRD Satellite 

Definitions.txt 

Used by Ground Control on page 133 – contains a list of 

satellites and associated frequencies and modes. 

Archiving 

The Archive option in the Tools menu takes a copy of the registry values and 

files used by all HRD programs (HRD, PSK31 Deluxe, Mapper) and copies 

them to another folder. 

 

 Select the destination folder 

 Browse the From folder 

 Browse the To folder 

 Start copying files and registry values. 

When you press Copy you see a DOS window appear briefly a few times. HRD 

uses regedit /e to copy the registry values, this in turn causes the DOS to appear. 

To restore registry values just double-click on a .reg file. Windows will prompt 

you to load the values into the registry.
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Annex: Logbook Database 

Introduction 

The logbook uses a very simple Access database. Originally DAO 3.5 (Access 

97) was used as the programming interface; this has been replaced with ODBC 

in early 2006 starting with version 3.3 build 984. 

Apart from getting away from DAO and the need to install the DAO support (not 

shipped with Windows) ODBC is needed for used of 64-bit Windows, as DAO 

is not supported on 64-bit Windows.  

The database structure is the same for DAO and ODBC. 

Each table contains an auto-incrementing primary key. 

To analyse the database yourself: 

 Start Microsoft Access, 

 Convert the database if necessary using the Convert Database 

option selected from the Tools menu; do not overwrite the 

database! 

 Use the Analyzer> Documenter option selected from the Tools 

menu. 

Notes: 

 Do not use programs such as Microsoft Access to convert the 

database – or if you do just make sure that you do not overwrite the 

database. If you convert to a newer version of Access you may not 

be able to open the database with HRD. 

 Take regular backups. 

Tables 

Bands 

This table defines the frequency ranges for the ADIF bands, used when 

exporting to ADIF. 

Columns 

Name Type Size 

PrimaryKey Long Integer 4 

MinFreq Long Integer 4 



MaxFreq Long Integer 4 

Title Text 32 

ADIF Text 32 

Comment Text 64 

Countries 

The country list; used to lookup a country based on prefix, also to cross-

reference a country and DXCC number. 

Columns 

Name Type Size 

PrimaryKey Long Integer 4 

Country Text 64 

DXCC Text 32 

Comment Memo - 

Prefix Memo - 

Logbook 

This table stores information for each QSO. 

Columns 

Name Type Size 

PrimaryKey Long Integer 4 

Created Date/Time 8 

Modified Date/Time 8 

Station Text 32 

EndTime Date/Time 8 

StartTime Date/Time 8 

Remark Memo - 

ReportRecv Text 32 

ReportSent Text 32 

BandMHz Text 32 

Mode Text 32 

Frequency Text 32 

Locator Text 32 

Country Text 64 

DXCC Text 10 

IOTA Text 10 

QSLRecv Text 10 

QSLSent Text 10 

QSLRecvDate Date/Time 8 

QSLSentDate Date/Time 8 

eQSLRecv Text 10 

eQSLSent Text 10 

eQSLRecvDate Date/Time 8 
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eQSLSentDate Date/Time 8 

eQSLStatus Text 255 

QSLVia Text 64 

Name Text 128 

Address Text 255 

QTH Text 255 

MyStation Text 128 

MyOperator Text 32 

MyOwner Text 32 

MyAntenna Text 128 

MyCallsign Text 32 

MyLocator Text 10 

MyPower Text 32 

MyName Text 32 

MyCountry Text 64 

MyStreet Text 64 

MyCity Text 64 

MyCounty Text 64 

MyState Text 64 

MyZip Text 20 

MySig Text 32 

MySigInfo Text 64 

MyLatitude Text 12 

MyLongitude Text 12 

MyCqZone Text 8 

MyItuZone Text 8 

MyIota Text 10 

Custom1 Text 64 

Custom2 Text 64 

Custom3 Text 64 

Custom4 Text 64 

Custom5 Text 255 

Custom6 Text 255 

AntAz Text 3 

AntEl Text 2 

AntPath Text 1 

SatName Text 32 

SatMode Text 32 

ContestCheck Text 8 

ContestClass Text 8 

ContestPrecedence Text 8 

ContestContest Text 64 

LocationCounty Text 64 

LocationState Text 64 

LocationContinent Text 2 

LocationArrlSect Text 4 



LocationCqZone Text 8 

LocationItuZone Text 8 

LocationDistance Text 10 

LocationLatitude Text 12 

LocationLongitude Text 12 

StationEmail Text 64 

StationUrl Text 64 

StationEquipment Text 255 

StationAge Text 4 

StationSig Text 32 

StationSigInfo Text 64 

StationTenTen Text 10 

PropagationAIndex Text 10 

PropagationKIndex Text 10 

PropagationMaxBursts Text 10 

PropagationNumBursts Text 10 

PropagationNumPings Text 10 

Modes 

The supported modes, this list contains all modes supported by ADIF. 

Columns 

Name Type Size 

PrimaryKey Long Integer 4 

Title Text 32 

ADIF Text 32 

Comment Text 64 

QRZ 

When a QRZ lookup is made a copy of the returned data is stored in this table so 

that subsequent lookups are much faster. 

The fields correspond to the fields extracted from the returned QRZ data. 

Columns 

Name Type Size 

PrimaryKey Long Integer 4 

QRZUpdated Date/Time 8 

QRZCallsign Text 255 

QRZName Text 255 

QRZAddr1 Text 255 

QRZAddr2 Text 255 

QRZCountry Text 255 

QRZGrid Text 255 

QRZHomePage Text 255 

QRZQslMgr Text 255 
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QRZLatitude Text 32 

QRZLongitude Text 32 

ADIF 

Ideally HRD‟s logbook will support all ADIF fields. The table below contains all 

ADIF fields as of ADIF spec 2.1.7 and the location in the Add/Modify window. 

Grateful thanks to Dave, AA6YQ for maintaining order in the Yahoo! ADIF 

group. 

This table is really a programmer‟s checklist to ensure essential fields are 

supported. ADIF fields that have not yet been added have empty values in HRD 

Field. 

 Antenna and Satellite are combined into one dialog. 

For ADIF information: http://groups.yahoo.com/group/adifdev/files/ . 

 

HRD Window HRD Field ADIF Field 

Antenna/Satellite Azimuth ANT_AZ 

Antenna/Satellite Elevation ANT_EL 

Antenna/Satellite Mode SAT_MODE 

Antenna/Satellite Name SAT_NAME 

Antenna/Satellite Path ANT_PATH 

Contact 10-10 TEN_TEN 

Contact Age AGE 

Contact Email EMAIL 

Contact Equipment RIG 

Contact SIG SIG 

Contact SIG info SIG_INFO 

Contact URL WEB 

Contest Check CHECK 

Contest Class CLASS 

Contest Contest CONTEST_ID 

Contest Precedence PRECEDENCE 

Location ARRL sect ARRL_SECT 

Location Continent CONT 

Location County CNTY 

Location CQ zone CQZ 

Location Distance DISTANCE 

Location ITU zone ITUZ 

Location Latitude LAT 

Location Longitude LON 

Location State/province STATE 

Main Address ADDRESS 

Main Band BAND 

Main Cntry COUNTRY 

Main Cntry (read-only) DXCC 

Main End TIME_OFF 

http://groups.yahoo.com/group/adifdev/files/


Main Freq FREQ 

Main IOTA IOTA 

Main Locator GRIDSQUARE 

Main Mode MODE 

Main Name NAME 

Main QTH QTH 

Main Remark COMMENT 

Main RST Recv RST_RCVD 

Main RST Sent RST_SENT 

Main Start QSO_DATE 

Main Start TIME_ON 

Main Station CALL 

My Station City MY_CITY 

My Station Country MY_COUNTRY 

My Station County MY_CNTY 

My Station CQ zone MY_CQ_ZONE 

My Station Equipment MY_RIG 

My Station IOTA MY_IOTA 

My Station ITU zone MY_ITU_ZONE 

My Station Lat MY_LAT 

My Station Locator MY_GRIDSQUARE 

My Station Lon MY_LON 

My Station Name MY_NAME 

My Station Operator call OPERATOR 

My Station Owner call OWNER_CALLSIGN 

My Station Power TX_PWR 

My Station SIG MY_SIG 

My Station SIG info MY_SIG_INFO 

My Station State MY_STATE 

My Station Street MY_STREET 

My Station ZIP MY_POSTAL_CODE 

Propagation A index A_INDEX 

Propagation K index K_INDEX 

Propagation Max bursts MAX_BURSTS 

Propagation MS shower MS_SHOWER 

Propagation Num bursts NR_BURSTS 

Propagation Num pings NR_PINGS 

Propagation Prop mode PROP_MODE 

Propagation Solar flux SFI 

QSL Info QSL Recv QSL_RCVD 

QSL Info QSL Recv QSLRDATE 

QSL Info QSL Sent QSL_SENT 

QSL Info QSL Sent QSLSDATE 

QSL Info QSL Via QSL_VIA 

Depreciated  OPERATOR 

Depreciated  VE_PROV 
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In ADIF files  PROGRAMID 

In ADIF files  PROGRAMVERSION 

t.b.a.  BAND_RX 

t.b.a.  FORCE_INIT 

t.b.a.  FREQ_RX 

t.b.a.  GUEST_OP 

t.b.a.  NOTES 

t.b.a.  OWNER_CALLSIGN 

t.b.a.  PFX 

t.b.a.  PUBLIC_KEY 

t.b.a.  QSL_RCVD_VIA 

t.b.a.  QSL_SENT_VIA 

t.b.a.  QSLMSG 

t.b.a.  QSO_COMPLETE 

t.b.a.  QSO_RANDOM 

t.b.a.  RX_PWR 

t.b.a.  SRX 

t.b.a.  SRX_STRING 

t.b.a.  STATION_CALLSIGN 

t.b.a.  STX 

t.b.a.  STX_STRING 

t.b.a.  SWL 
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Annex: Links 

HRD 

Homepage – http://hrd.ham-radio.ch/. 

Forums – http://forums.ham-radio.ch/. 

Yahoo! Mailing list – http://groups.yahoo.com/group/ham-radio-deluxe/. 

Other Software 

BV Software by DF3CN - http://www.df3cb.com/ . Excellent QSL management 

and label printing software. 

DXLab by Dave Bernstein AA6YQ - http://www.qsl.net/dxlab. 

IrfanView - http://www.irfanview.com/. Great image viewer and sound file 

player. 

http://hrd.ham-radio.ch/
http://forums.ham-radio.ch/
http://groups.yahoo.com/group/ham-radio-deluxe/
http://www.df3cb.com/
http://www.qsl.net/dxlab
http://www.irfanview.com/
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Annex: Building HRD 

Overview 

HRD is a Windows-only program; please do not ask for the source code for 

porting to other platforms such as Linux or the Macintosh. Not only are there 

legal reasons (see below), it‟s also a technical waste of time! It would be much 

easier to start from scratch than try to port the code. 

The information here is provided for anyone who takes over the development 

and maintenance of HRD for whatever reason. 

Note that commercial programming libraries have been used – this saves a lot of 

time and provides a much better „look and feel‟. 

The HRD source is copied into a password-protected ZIP archive every night, 

transferred to a backup server then uploaded to an archive folder on a central 

web server. 

The source is copyright (s) Simon Brown, HB9DRV unless already copyrighted. 

Source Code 

The root folder is \Ham Radio containing the folders in the table below. 

 

Folder Description 

Alerter Source for the Alerter module used by the satellite tracking. The 

Alerter is a standalone executable that announces upcoming 

satellite passes. 

APEX Contains Olectra Chart 6.0.6 now owned by 

http://www.componentone.com/ and called ComponentOne Chart. 

A license is required to use the contents of this folder for 

development, the olch2d32.dll DLL can be redistributed. 

boost_1_20_1 The boost library, proves regular expression support used in 

PSK31 Deluxe. 

CD Image The CD Image which contains a full HRD distribution containing 

absolutely everything (except the source). 

Codejock 

Software 

Xtreme Toolkit Pro - a fine programming library from 

http://www.codejock.com/ . 

A license is required to use the contents of this folder for 

development. 

Common Code common to more than one HRD component. 

DDE Demos DDE demonstration programs, source can be distributed. 

Debug All executable code compiled in debug mode, this is not shipped to 

http://www.componentone.com/
http://www.codejock.com/


end-users. 

Defaults Default files shipped in the HRD kits. Examples are colour 

schemes and satellite data. 

Doc Source for this document. The PDF is in the Ship sub-folder. 

Dundas A fine programming library from http://www.dundas.com/ 

subsequently sold to http://www.theultimatetoolbox.com/ . 

A license is required to use the contents of this folder for 

development. 

Dundas Software 

001 

See Dundas above. 

HamRadioDeluxe The source code for ham Radio Deluxe. 

HRDSats The source code for the HRD Sats DLL. This may be redistributed; 

it comes mostly from public domain sources and freely available 
work from other people, notably Michael F. Henry. 

HRDSync The source code for the program used to synchronise multiple 

instances of HRD. 

InstallShield The InstallShield folder contains the InstallShield DevStudio 9 

project that builds the distribution kit. A licence is needed for 
InstallShield products. 

The project file is Ham Radio Deluxe.ism . 

Kit To build a kit run Make.bat . 

lame-3.92 Open source MP3 encoder, used by the Audio Grabber. 

mad-0.14.2b Source code to produce a DLL that converts MP3 files to WAV or 

PCM. It is based on the open source library libmad. 

madlldlib See mad-0.14.2b above. 

Mapper Source code for Mapper, slowly being replaced with Google Earth 

and Google Maps. 

PSK31 Deluxe Source for PSK31 Deluxe. 

PSKCore119 The PSK31 engine, copyright 2000, Moe Wheatley, AE4JY. 

Licence is not needed. 

Release All executable code compiled in release mode, this is shipped to 

end users. 

RemoteSvr The source code for the HRD Remote Server. 

Workspace Contains the Microsoft VisualStudio workspace HamRadio.dsw . 

Additional Libraries 
You also need: 

 Microsoft Speech SDK 5.1 (or higher), 

 Microsoft Driver Development kit for Windows 2000 (or higher) 

also known as NTDDK, 

 Microsoft Platform SDK for Windows. 

The Platform SDK and NTDDK provide definitions not available in the files 

shipped with Visual C++ version 6.0 from Microsoft. If you are using a newer 

version of C++ you may not need these libraries. 

As a Visual C++ programmer you will be familiar with the use of the Microsoft 

libraries. 

http://www.dundas.com/
http://www.theultimatetoolbox.com/
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Tools 

To compile HRD you need Visual C++ version 6.0 from Microsoft. There is no 

reason to use a later version such as Visual Studio 2005 as by all accounts the 

user interface is less friendly and the compiler is slower. 

To build kits you need InstallShield DevStudio 9. As this version can no longer 

be purchased you will have to buy the latest version available. 

Note that you will need licences for the products listed in Source Code on page 

183. 

 ComponentOne Chart, 

 Codejock Software‟s Xtreme Toolkit Pro, 

 Ultimate Toolbox. 

Visual Studio Settings 
In the examples below Visual Studio and the SDKs / DDKs are installed on the 

C: drive, the Ham Radio Deluxe source is on the D: drive. 

Include Directories 

The recommended include directories are: 

 C:\MICROSOFT SDK\INCLUDE 

 C:\Program Files\Microsoft Visual Studio\VC98\INCLUDE 

 C:\Program Files\Microsoft Visual Studio\VC98\MFC\INCLUDE 

 C:\Program Files\Microsoft Visual Studio\VC98\ATL\INCLUDE 

 C:\NTDDK\INC;D:\MICROSOFT SPEECH SDK 5.1\INCLUDE 

 D:\Ham Radio\Dundas Software 001\Ultimate Toolbox\include 

Library Directories 

 C:\Program Files\Microsoft Visual Studio\VC98\LIB 

 C:\Program Files\Microsoft Visual Studio\VC98\MFC\LIB 

 C:\MICROSOFT SDK\LIB 

 D:\Ham Radio\APEX\LIB 

 D:\MICROSOFT SPEECH SDK 5.1\LIB\I386 

 D:\HAM RADIO\BOOST_1_20_1\LIBS\REGEX\LIB\VC6 

 D: \HAM RADIO \DUNDAS SOFTWARE 001\ULTIMATE 

TOOLBOX\LIB\LIBS 

 D: \HAM RADIO \DUNDAS\ULTIMATE TOOLBOX\LIB\LIBS 

Building 

To rebuild: 

 Open the workspace, 

 Build all Win32 Release configurations, 



 Build the kit.
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Auto-detect, 20 
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Band Layouts, 55 

Band Selection, 25, 26 
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BSP, 25 

Building, 183 

Buttons, 26, 32 

Cabrillo, 91 

CAT Commands, 101 

CATbox, 14 

CI-V, 154 

CI-V Address, 20 

CI-V Transceive, 20 

COM Port, 20 

COM Port TX, 41 

Command Tester, 151 

Comms, 40 

Computer, 13 

Configuration, 82 

Connecting, 20 
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Countries, 85, 172 

CSIDL_APPDATA, 169 

CTS, 20 

Current Data, 137 

Custom Fields, 83 

Customise Layout, 29 

Database Configuration, 82 

Date & Time, 26 

DDE, 142 

DDE Server, 142 

DDE Support, 59 

Dem-o-matic, 13, 19 

DF3CN, 179 

Display Scroll, 26 

Docking Panes, 41 

Dropdowns, 27 

DTR, 20 

DX Cluster, 61 

DXLab, 179 

Eddystone EA12, 9 

Elecraft, 13, 102, 104, 153 

Export, 89 

Export to ADIF, 90 

Export to Cabrillo, 91 

Faceplate, 33 
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Filter, 155 

Fine Tuning, 25 
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Frequency Display, 24 

Frequency range, 56 

FT-817, 135 

FT-817 Commander, 9 
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G4ZLP, 14 

Griffin Powermate, 24, 39 

Ground Control, 131 

HB9DRV, 9 

HRD Interface guide, 14 

HRDRemoteSvr.cfg, 112, 121 

IC-703, 9 

IC-910H, 134 

ICOM, 13, 103, 134, 154 

ICOM Calibration, 42 

Import, 89 

Include Directories, 183 

Info: Modes, 42 

Info: Options, 43 

Installation, 15 

InstallShield, 183 

Interfacing, 14 

Internet, 44 

IrfanView, 179 

Johannes Kepler, 127 



K1EL, 93 

Kenwood, 13, 102 

Keplerian elements, 127 

Kevin Crockett, 10 

Layout, 30 

Library Directories, 183 

Linear Transponders, 135 

Linux, 181 

LINUX, 13 

Locator, 124 

Logbook, 172 

Logbook Database, 171 

Logbook of The World, 90 

Logfile, 87 

Long path, 124 

LoTW, 90 

LPT1, 52 

LPT2, 52 

LPT3, 52 

Macintosh, 13, 181 

Macros, 101 

Main Tuning, 25 

Meters, 35 

Microsoft Jet 4.0, 15 

Mode, 155 

Modes, 86, 174 

Mouse Wheel, 45 

MP3, 47, 48 

MP3 Player, 49 

Mutual Visibility, 138 

My Station, 83 

N8VB, 20, 110, 147 

N8VB vCOM, 161 
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NORAD, 127 

Notepad, 91 
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ODBC tracing, 92 

OH2AQ, 61 

Out Of Band, 44 

Parallel port, 51 

Performance, 92 

Philip Covington, 20 

PHP1PH, 9 

Plot, 141 

Portmon, 159 

Ports, 162 

Preview, 88 

Print Options, 88 

Printing, 88 

Problem Solving, 116 

Program Options, 39 

QRZ, 174 

QRZ Cache, 86 

QRZ.com, 86 
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Quick Save, 107; Markers, 107 

Radio Display, 23 

Record, 47 

Registry, 169 

Remote Connection, 115 

Remote Server, 109, 165 

Requirements, 13 

Rotator, 123 

RTS, 20 

Satellite Tracking, 127 
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Schemes, 29 

SDP4, 127 

Selection Window, 45 
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Short path, 124 
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Sliders: Appearance, 36 
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Snapshots, 106 
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Speed, 20 
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Supported Radios, 13 
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T.S. Kelso, 129 

Ten-Tec, 13, 103 

Toolbars, 46 
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Virtual COM ports, 147 
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WinKey, 93 

Yaesu, 13, 104, 134, 156 

 


